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C H A P T E R 1

Introducing AFT Impulse

Welcome to AFT Impulse™ 9, Applied Flow Technology's powerful
waterhammer modeling tool. With AFT Impulse you can model
transients caused by a wide range of pipe system behavior. This will
allow you to understand transient pressure extremes and, when
necessary, size and locate surge suppression equipment.

AFT Impulse includes a steady-state solution engine which solves for
the system initial conditions. These results are used to automatically
initialize the transient model. The engineer accesses these capabilities
through an advanced graphical interface, which includes built-in
expertise to guide the engineer through the modeling process.

AFT Impulse has two available add-on modules which extend AFT
Impulse’s modeling capabilities into new areas.
l The Settling Slurry (SSL) module allows the engineer to perform the

complex property and system interaction calculations associated
with settling slurry flows.

l The Pulsation Frequency Analysis (PFA) module allows the
engineer to determine resonant frequencies that can result in
excessive vibration and damage to systems.

Designing for waterhammer

Waterhammer can cause catastrophic failure of pipe systems and
damage expensive equipment. Properly addressing such issues at the
design stage is essential. An AFT Impulse model allows the engineer to
better understand and predict the dynamic behavior of the pipe system.



When undesirable waterhammer transients are identified at the design
stage, different strategies to reduce surge pressures can be evaluated.
These may include using surge suppression equipment, modifying the
design, or modifying the system operation.

Sometimes the undesirable transients are not discovered until after the
system is built. In such cases, AFT Impulse can provide critical insight
into the cause of the problem and allow the engineer to assess design
and/or operational modifications to resolve the issue.

Modeling capabilities
AFT Impulse provides a broad array of features to model pipe system
transients. These include:
l Transients in open and closed (recirculating) systems

l Network systems that branch or loop

l Systems with valve transients

l Systems with pump transients

l Systems with turbine transients

l Systems with pressure or flow control valve transients

l Systems with transient cavitation and liquid column separation

l Systems with surge suppression devices such as accumulators, surge
tanks and vacuum breaker valves

l Systems with variable density and viscosity

l Multiple design cases in a single model file

l Non-Newtonian fluid behavior

Add-on module capabilities (optional)
l System performance for settling slurry calculations (SSL module)

l Identification of resonant frequencies (PFA module)

l Positive displacement pump speeds which excite resonant
frequencies (PFA module)

2 AFT Impulse™ 9 Quick Start Guide



Chapter 1 Introducing AFT Impulse 3

The steady-state solver

Before a waterhammer model can be run, the initial steady-state
conditions are required. AFT Impulse obtains the steady-state solution
using a Newton-Raphson matrix solution algorithm to obtain a mass and
momentum balance. The algorithm is similar to that used in the
acclaimed AFT Fathom™.

If desired, AFT Impulse can be run in “Steady Only” mode where only
the steady flow pipe hydraulics are modeled. When run in “Transient”
mode, the steady flow solution is used to automatically initialize the
transient solution. This convenience helps the user avoid the often
error-prone process of manually setting up the initial conditions, and it
allows the user to quickly and safely modify and rerun the model.

The transient solver

AFT Impulse employs the traditional Method of Characteristics (MOC)
to solve the transient equations of pipe flow. A mass and momentum
balance is performed at all computing stations in each pipe, accurately
representing the propagation of transient pressure waves throughout the
system.

The MOC is an explicit solution technique, where the Solver marches in
time for a duration specified by the user.

Thermophysical property data

AFT Impulse derives physical properties from one of five sources. The
first is the standard AFT Impulse set of incompressible fluids which
contains data for about 30 common fluids (called AFT Standard).

The second is User Specified Fluid, for which data is provided by the
user. The third is water data from the ASME Steam tables.

The fourth is the NIST REFPROP library, first introduced in AFT
Impulse 7. REFPROP is licensed from the National Institute of
Standards and Technology and is included in AFT Impulse. REFPROP
has a library of approximately 150 fluids and supports user specified



fluid mixtures. AFT Impulse is restricted to non-reacting mixture
calculations.

The fifth is the Chempak™ library. Chempak is licensed from Madison
Technical Software and is offered as an optional add-on to AFT
Impulse. Chempak has a library of approximately 700 fluids and
supports user specified fluid mixtures. AFT Impulse is restricted to non-
reacting mixture calculations.

Engineering assumptions in AFT Impulse

AFT Impulse is based on the following fundamental fluid mechanics
assumptions:
l Liquid flow (liquid full)

l One-dimensional flow

l No chemical reactions

l Wavespeed remains constant during transients

l Non-condensable gas release is negligible

l Bubbles that form during transient cavitation do not move

AFT Impulse Primary Windows

The AFT Impulse window has five windows that work in an integrated
fashion. Each is located on a separate, movable tab. You work
exclusively from one of these windows at all times. For this reason, they
are referred to as Primary Windows.

Of the five Primary Windows, two are input windows, two are output
windows, and one displays both input and output information. Figure 1.1
shows the relationships between the Primary Windows.
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Figure 1.1 Primary Window workflow in AFT Impulse

Input windows
The two windows that function exclusively as input windows are the
Workspace window and the Model Data window. These two windows,
one graphical and the other text-based, work together to process model
input data with immense flexibility. The tools provided in these two
windows allow you to model a large variety of pipe networks.

The Visual Report window can function in support of both input and
output data. As an input window, it allows you to see the input data
superimposed on the pipe system schematic created on the Workspace.

Output windows
The two windows that function exclusively as output windows are the
Output window and the Graph Results window. The Output window is
text-based, while the Graph Results window is graphical. These two
windows offer a powerful and diverse range of features for reviewing
analysis results for modeling errors, gaining a deeper understanding of
the pipe system's flow behavior, and preparing the results for
documentation.

As an output window, Visual Report allows you to see the output results
superimposed on the pipe system schematic created on the Workspace.

The five Primary Windows form a tightly integrated, highly efficient
system for entering, processing, analyzing, and documenting transient
incompressible flow analyses of pipe networks.



Note: AFT Impulse supports multiple monitors. You can click and drag
any of the five Primary Window tabs off of the main AFT Impulse
window.  Once you drag one of the Primary Windows off of the Impulse
window, you can move it anywhere you like on your screen, including
onto a second monitor in a dual monitor configuration. To add the
Primary Window back to the main AFT Impulse primary tab window
bar, simply click the X button in the upper right of the Primary Window.

Note: To ensure that your results are the same as those presented in this
documentation, these examples should be run using all default AFT
Impulse settings, unless you are specifically instructed to do otherwise.

6 AFT Impulse™ 9 Quick Start Guide
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Valve Closure Example

This chapter is designed to give you the big picture of AFT Impulse's
layout and structure. Some of the more basic concepts will be used to
build a four-pipe, five-junction model which shows the waterhammer
transients that result when a valve is closed.

A number of other example model discussions are included on the
AFT website. To get there, open the Help menu and choose Show
Examples or go to www.AFT.com.

Topics covered
l Building a basic model

l Entering pipe and junction data

l Defining Analysis Setup

l Entering transient data

l Sectioning pipes

l Graphing output results

Required knowledge

No prior knowledge is required for this example.



Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT Impulse installation:
l US - Beginner Valve Closure.imp

This example is also provided in Metric units under file name, Metric -
Beginner Valve Closure.imp.

This example will require you to build the model from scratch to help
familiarize yourself with the steps required to build a complete model in
AFT Impulse. Therefore, use this example model file as a reference
only.

Problem statement

For this problem, water flows from two separate supply tanks and
combines into a single 12 inch line before flowing to a downstream
reservoir. The flow is controlled by opening and closing a valve in the
12 inch line.

This model will simulate the closure of the valve over a period of one
second. The valve will stay closed for the remaining simulation
duration.

Graph the pressure at the inlet of the valve over the entire simulation
duration to determine the maximum pressure that occurs at the valve
during the transient.

Step 1. Start AFT Impulse
Ø To start AFT Impulse, click Start on the Windows taskbar and choose

AFT Impulse. (This refers to the standard menu items created by setup.
You may have chosen to specify a different menu item).

A. The Startup window
As AFT Impulse is started, the AFT Impulse Startup window appears, as
shown in Figure 2.1. This window provides you with several options
you can choose before you start building a model. 
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Figure 2.1 AFT Impulse Startup window

Some of the available actions from the Startup window are:
l Open a recent model or browse to a model or an Example

l Activate an Add-on Module

l Select “ASME Water” or a recently used fluid as the Working Fluid

l Review or modify Modeling Preferences

l Select a Unit System

l Filter units to be Common Only or Common Plus Selected
Industries

l Choose a Grid Style



l Select a Default Pipe Material

l Access other Resources such as Help Files and Video Tutorials

If this is the first time that you have started AFT Impulse, Modeling
Preferences will be expanded in the middle section of the Startup
Window, as shown in Figure 2.2. If this is not the first time that you
have started AFT Impulse, the Startup Window will appear with
Modeling Preferences collapsed, as shown in Figure 2.1.

When collapsed, you can view your current Modeling Preferences at the
bottom of Start a New Model. To further review or adjust your
preferences, click the “Modify>>” button (see Figure 2.1).

Figure 2.2 Startup Window with Modeling Preferences Expanded
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With Modeling Preferences expanded, as in Figure 2.2, select “Both
with US Defaults” under Unit System. Select “Common Only” under
Filter to show only commonly used units, instead of “All Units”.

You can “Show Sample Units” to see which units will be included based
on your selections, as shown in Figure 2.3.

Figure 2.3 Show Sample Units with “Common Only” Selected



The other Filter option is “Common Plus Selected Industries”, which
will add units from the industries that you select. Once you have
finished modifying your Modeling Preferences, click “Remember My
Preferences and Hide”. Now click “Start Building Model”.

The Workspace window is the initial active (large) window, as seen in
Figure 2.4. The five tabs in the AFT Impulse window represent the five
Primary Windows. Each Primary Window contains its own toolbar that
is displayed directly beneath the Primary Window tabs.

Figure 2.4 Build the model in the Workspace window. The other
four Primary Windows are on the tabs along the top of
the Workspace.

B. The Workspace window
The Workspace window is the primary vehicle for building your model.
This window has three main areas: the Toolbox, the Quick Access
Panel, and the Workspace itself. The Toolbox is the bundle of tools on
the far left. The Quick Access Panel is displayed on the far right. It
gives easy access to a variety of features such as the Scenario Manager,

12 AFT Impulse™ 9 Quick Start Guide



Chapter 2 Valve Closure Example 13

and viewing pipe and junction properties. The Workspace takes up the
rest of the window.

You will build your waterhammer model on the Workspace using the
Toolbox tools. At the top of the Toolbox is the Float Toolbar. From
here, you can choose the location of the Toolbox in reference to the
Workspace by specifying Dock Left, Float, or Dock Right. Below the
Float Toolbar are two drawing tools. The Pipe Drawing tool, on the
upper left, is used to draw new pipes on the Workspace. Next to this
tool is the Annotation tool. The Annotation tool allows you to create
annotations and auxiliary graphics.

Below the two drawing tools are twenty-five icons that represent the
different types of junctions available in AFT Impulse. Junctions are
components that connect pipes and also influence the pressure or flow
behavior of the pipe system. The junction icons can be dragged from the
Toolbox and dropped onto the Workspace.

When you pass your mouse pointer over any of the Toolbox tools, a
tooltip identifies the tool's function.

C. Unpinning the Quick Access Panel
By default, the Quick Access Panel is pinned to the Workspace window
so that it is constantly displayed. The Quick Access Panel can be
unpinned so it is only displayed when the mouse is moved over the tab
displayed on the right edge of the Workspace window. Unpin the Quick
Access Panel by clicking on the pin icon displayed in the top right
corner of the Quick Access Panel (Figure 2.4). The Quick Access Panel
will be unpinned for the remainder of the examples in this guide.

Step 2. Lay out the model

To lay out the valve closure model, you will place five junctions on the
Workspace. Then you will connect the junctions with pipes.

A. Place a Reservoir
Ø To start, drag a Reservoir junction from the Toolbox and drop it on

the Workspace. Figure 2.5 shows the Workspace with one Reservoir.



Objects and ID numbers
Items placed on the Workspace are called objects. All objects are
derived directly or indirectly from the Toolbox. AFT Impulse uses three
types of objects: pipes, junctions and annotations.

All pipe and junction objects on the Workspace have an associated ID
number. For junctions, this number is placed directly above the junction
by default and prefixed with the letter “J”. Pipe ID numbers are prefixed
with the letter “P”. You can optionally choose to display either or both
the ID number and the name of a pipe or junction. You also can drag the
ID number/name text to a different location to improve visibility.

The Reservoir you have created on the Workspace will take on the
default ID number of 1. You can change this to any desired number
greater than zero but less than 100,000.

Figure 2.5 Valve closure model with first junction placed

Editing on the Workspace
Once on the Workspace, junction objects can be moved, copied, pasted,
and edited using the features on the Edit menu.
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B. Place the other junctions
If a new junction type you want to add is already on the Workspace, you
have the option of duplicating that junction. You do this by choosing
Duplicate from the Edit menu. Either duplicate the first Reservoir or
drag a new Reservoir junction onto the Workspace. Place the new
Reservoir somewhere below the first Reservoir junction (Figure 2.6).

Note: The relative location of objects is not important. Distances and
heights are defined through dialog boxes. The relative locations on the
Workspace establish the connectivity but have no bearing on the length
or elevation relationships. The Isometric grid (see Chapter 5) can be
used to visually represent the three-dimensional nature of a system.

Drag a Branch, Valve, and third Reservoir junction and drop them on
the Workspace so that your model appears similar to Figure 2.6.

Figure 2.6 Valve closure model with all junctions placed

The calculations will not be affected if the icons do not line up exactly.
However, your model may have a nicer appearance if they do. You can
align the icons by using the Align features from the Arrange menu.



Before continuing, save the work you have done so far. Choose “Save
As” from the File menu and enter a file name (Valve Closure, perhaps)
and AFT Impulse will append the “.imp” extension to the file name.

C. Draw a pipe between J1 and J3
Now that you have five junctions, you need to connect them with pipes.

Ø To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The
pointer will change to a crosshair when you move it over the
Workspace. Left-click and drag to draw a pipe below the junctions,
similar to that shown in Figure 2.7.

Figure 2.7 Valve closure model with first pipe drawn

The pipe object on the Workspace has an ID number (P1) that is shown
near the center of the pipe.

Ø To place the pipe between J1 and J3, use the mouse to grab the pipe
in the center, drag it so that its left endpoint falls within the J1 Reservoir
icon, then drop it there (see Figure 2.8). Next, grab the right endpoint of
the pipe and stretch the pipe, dragging it until the endpoint terminates
within the J3 Branch icon (see Figure 2.9).
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Figure 2.8 Valve closure model with first pipe partially connected

Figure 2.9 Valve closure model with first pipe fully connected



D. Add the remaining pipes
A faster way to add a pipe is to draw it directly between the desired
junctions.

Ø Activate the Pipe Drawing Tool again, position the mouse pointer on
the J2 Reservoir, then press and hold the left mouse button. Stretch the
pipe across to the J3 Branch, and then release the mouse button.
Continue drawing pipes P3 and P4 as indicated in Figure 2.10. After all
the pipes are drawn, all the objects in the model are graphically
connected. Save the model by selecting Save in the File menu or by
clicking on the “save” icon on the Main Toolbar.

Figure 2.10 Valve closure model with all pipes and junctions
placed

Reference positive flow direction
There is an arrow on each pipe that indicates the reference positive flow
direction for the pipe. AFT Impulse assigns a flow direction
corresponding to the direction in which the pipe is drawn.
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You can reverse the reference positive flow direction by choosing
“Reverse Direction” from the Arrange menu or selecting the Reverse
Pipe Direction button on the Workspace Toolbar.

In general, the reference positive flow direction is used for reference
purposes only and need not be the actual flow direction. However, when
used with pumps and certain other junction types the pipes must be in
the appropriate forward flow direction because that is how AFT Impulse
determines which side is suction and which is discharge. If the reference
positive flow direction is the opposite of that obtained by the Solver, the
output will show the flow rate as a negative number.

Note: Some users find it desirable to lock objects to the Workspace
once they have been placed. This prevents accidental movement and
disruption of the connections. You can lock all the objects by choosing
Select All from the Edit menu, then selecting Lock Object from the
Arrange menu. The Lock Object button on the Workspace Toolbar will
appear depressed, indicating it is in an enabled state, and will remain so
while any selected object is locked. Alternatively, you can use the grid
feature and “Snap to Grid”, which is turned on by default when you first
start AFT Impulse. The grid options can be modified through the User
Options window from the Tools menu.

Step 3. Specify Analysis Setup

Analysis Setup is a new feature to AFT Fathom 12 that replaces the
Checklist. Select modules, define fluid properties, specify pipe and
junction properties, section pipes, specify the simulation duration, adjust
solution control, and more all from the Analysis Setup window.

Ø Next, click Analysis Setup on the Common Toolbar at the top of the
AFT Impulse window. This opens the Analysis Setup window (Figure
2.11). The Analysis Setup window contains six or more groups
depending on which modules you may be using. Each group has one or
more items. A fully defined group has every item within it defined with
all required inputs. Complete every group to run the Solver. A group or
item that needs more information will have a red exclamation point to
the left of the group or item name. After completing a group, the group
icon shows a green circle with a checkmark. After defining all groups,



thus completing the Analysis Setup, the Model Status light in the lower
right corner turns from red to green.

Note: If you are running your model in steady state mode only, the Pipe
Sectioning and Output group and the Transient Control group will
appear to be fully defined because they pertain to the transient analysis
only. To change back and forth between the steady state and transient
analyses, choose either “Steady Only” or “Transient” from the
Simulation Mode/Duration panel in Analysis Setup or from the Analysis
menu.

Analysis Setup can also be opened by clicking the Model Status light on
the Status Bar at the bottom right corner of the AFT Impulse window
(Figure 2.4).

A. Specify the Modules group
Under the Modules group, click on the Modules item to open the
Modules panel, shown in Figure 2.11. Here, you can enable and disable
add-on modules. These add-on modules include Pulsation Frequency
Analysis and Settling Slurry. By default, the model will have all
modules disabled. Therefore, make no changes to this panel for this
example.
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Figure 2.11 Analysis Setup tracks the defined and undefined
model input

B. Specify the Fluid Properties group
The Fluid Properties group consists of four items: Fluid, Viscosity
Model, Variable Fluids, and Laminar and Non-Newtonian Corrections.
On the Fluid panel, you specify the fluid used in the model. On the
Viscosity Model panel, you select which viscosity model to use -
Newtonian is used by default. On the Variable Fluids panel, you can
specify constant fluids properties, the default selection, or variable fluid
properties. Finally, on the Laminar and Non-Newtonian Corrections
panel, you can specify the type of corrections to apply with laminar flow
or non-Newtonian fluids.

By default, only the Fluid panel requires input. Click on the Fluid item
to open the Fluid panel, shown in . You can directly enter density and
viscosity data (using User Specified Fluid), select a fluid from the
standard AFT Fathom fluid library (AFT Standard), or select Water Data
from ASME Steam Tables. Additionally, you can select from fluids
and/or create mixtures using the NIST REFPROP library (included in
AFT Fathom) or the Chempak library (an optional add-on to AFT



Fathom). You can also add your own custom fluids to the AFT Standard
library.

Ø Select the AFT Standard library and select Water (liquid) in the
Fluids Available in Library list, then click the “Add to Model” button.
Enter a temperature of 70 deg. F. This satisfies the required inputs for
the Fluid panel and Fluid Properties group. This Fluid panel should
appear as shown in Figure 2.12.

Figure 2.12 The Fluid panel is where you specify the fluid

C. Specify the Pipes and Junctions group
The third group in Analysis Setup, Pipes and Junctions, is not as
straightforward to satisfy as the first two. This item encompasses the
proper input data and connectivity for all pipes and junctions.

Object status
Each pipe and junction have an object status. The object status tells you
whether the object is defined according to AFT Impulse’s requirements.
To see the status of the objects in your model, click the light bulb icon
on the Workspace Toolbar (alternatively, you could choose “Show
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Object Status” from the View menu). Each time you click the light bulb,
“Show Object Status” is toggled on or off.

When “Show Object Status” is on, the ID numbers for all undefined
pipes and junctions are displayed in red on the Workspace. Objects that
are completely defined have their ID numbers displayed in black. (These
colors are configurable through User Options from the Tools menu).

Because you have not yet defined the pipes and junctions in this
example problem, all the objects’ ID numbers will change to red when
you turn on “Show Object Status”

Showing undefined objects
Another useful feature is the List Undefined Objects window (Figure
2.13). This can be opened from the View menu by clicking on “List
Undefined Objects”, or from the Workspace toolbar. Here all objects
with incomplete information are listed. Clicking on an undefined pipe or
junction will display the property data that is missing. Click the close
button in the bottom right to stop showing this window.

Figure 2.13 The List Undefined Objects window lets you see the
undefined properties for each undefined object

Enter data for the reservoirs
As shown in Figure 2.10, the J1 junction is a Reservoir junction.



Ø To define the first reservoir, open the J1 Reservoir Properties window
(Figure 2.14) by double-clicking on the J1 junction.

Note: You can also open an object's Properties window by selecting the
object (clicking on it) and then either pressing the Enter key or clicking
the Open Pipe/Junction Window icon on the Workspace Toolbar.

Ø Enter the following properties into the J1 Reservoir Properties
window:
1. Make sure the Tank Model is set to “Infinite Reservoir”

2. Enter 50 feet for the Liquid Surface Elevation. You can assign any
unit found in the adjacent drop-down menu of units.

3. Enter 0 psig for the Liquid Surface Pressure

4. Enter 10 feet for the Pipe Depth (ensure that the radio button next
to Pipe Depth is selected)

Note: Change default units for many parameters (such as feet for length)
in User Options, found in the Tools menu under Preferred Units.

You can give the object a name, if desired, by entering it in the Name
field at the top of the window. By default, the junction’s name indicates
the junction type. In Figure 2.14, the name of this Reservoir has been
changed to Supply Tank A. The name can be displayed on the
Workspace, Visual Report or in the Output.

Most junction types can be entered into a custom library, allowing the
junction to be used multiple times or shared between users. To select a
junction from the custom library, choose the desired junction from the
Library Jct list in the junction’s properties window. The junction will get
the properties from the library.
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Figure 2.14 Properties window for Reservoir J1

The “Copy Data From Jct” list will show all the junctions of the same
type in the model. This will copy the user selected parameters from an
existing junction in the model to the current junction.

Using the tabs in the properties windows
The information in the properties windows is grouped into categories
and placed on separate tabs. Click the tab to bring its information
forward. Figure 2.14 is an example of a Reservoir Properties window.

If there is only one pipe connected to the reservoir, the depth can be
entered directly on the diagram on the Reservoir Model tab for
convenience. The depth can also be entered no matter the number of
pipes on the Pipe Depth & Loss Coefficients tab. The pipe table allows
you to specify entrance and exit loss factors for each pipe connected to
the tank (in this case there is only one). The default selection is for the



loss factors to be specified as zero. To change the loss factors later, click
within the pipe table and enter the loss.

The Optional tab allows you to enter different types of optional data.
You can select whether the junction number, name, or both are
displayed on the Workspace. Some junction types also allow you to
provide a guess for initial pressure or other junction-specific data.

Each junction has a tab for notes, allowing you to enter text describing
the junction or documenting any assumptions.

The highlight feature displays all the required information in the
Properties window in light blue. The highlight feature is on by default.
You can toggle the highlight off and on by double-clicking anywhere in
the window above the tabs or by pressing the F2 key. The highlight
feature can also be turned on or off by selecting “Highlight in Pipe and
Jct Windows” from the View menu. Note that the highlight feature is
turned off in the Examples models.

Ø Click OK. If “Show Object Status” is turned on, you should see the J1
ID number turn black again, telling you that J1 is now defined.

Ø Next, repeat this process for junctions J2 (Supply Tank B) and J5
(Discharge Tank) with the following data:
l For J2, use a Liquid Surface Elevation of 45 feet, a Pipe Depth of 10

feet, and a Liquid Surface Pressure of 0 psig
l For J5, use a Liquid Surface Elevation of 5 feet, a Pipe Depth of 5

feet, and a Liquid Surface Pressure of 0 psig

The Inspection feature
You can check the input parameters for J1 quickly, in read-only fashion,
by using the Inspect feature. Position the mouse pointer on the J1
Reservoir junction and hold down the right mouse button. An inspection
window appears, as shown in Figure 2.15.

Inspecting is a faster way of examining the input in an object than
opening the properties window.
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Figure 2.15 Inspecting junction properties from the Workspace by
clicking and holding the right mouse button

Enter data for the branch
Ø Open the J3 properties window and enter an elevation of 0 feet.

Enter data for the valve
The J4 Valve junction will be the initiator of the transient.

Ø Double-click the J4 junction icon to open the Valve Properties window
(Figure 2.16)
1. Enter an Inlet Elevation of 0 feet

2. Choose Cv as the Loss Model enter a value of 1000 (this is the
steady-state Cv)



Figure 2.16 Input data for Valve junction J4

3. Click the Transient tab and select Time under “Initiation of
Transient” to indicate that the valve closure will be initiated at the
time you specify, then enter the following Cv vs. Time data for the
valve’s Cv at various times during the simulation (Figure 2.17).

Time (seconds) Cv

0 1000

0.4 400

0.8 100

1 0

2 0
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The first data point (Cv = 1000 at time zero) must match the steady-state
value (entered on the Loss Model tab). The transient data represents the
valve as initially open. The valve then closes over a period of one
second (a Cv of zero means the valve is closed). The valve then stays
closed for the rest of the simulation.
4. Click OK. There should now be a “T” symbol next to the Valve

junction in the Workspace, indicating that transient data is entered
for the junction.

Figure 2.17 Transient input data for Valve Junction J4

Enter data for Pipe P1
Data for pipes and junctions can be entered in any order. In this
example, the junctions were done first. The next step is to define all the
pipes. To open the Pipe Properties window, double-click the pipe object
on the Workspace.

Ø First, open the Pipe Properties window for Pipe P1. The Pipe Model
tab opens by default (Figure 2.18).



1. In the Pipe Material field, choose "Steel - ANSI"

2. In the Size and Type fields, choose "10 inch" and "STD (schedule
40)", respectively

3. Specify the length as 200 feet

4. For the Friction Model field, make sure “Standard” is selected

5. Make sure the Pipe Support is “Thick-Walled Anchored Upstream”

Figure 2.18 Pipe Properties window for Pipe P1

The Pipe Properties window
The Pipe Properties window offers control over all important hydraulic
parameters that are related to pipes.

The Inspect feature can be accessed not only from pipes and junctions
located on the Workspace, but also from within the Properties window
of each pipe (and certain junctions). This is helpful when you want to
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quickly check the properties of objects that connect to a pipe or junction
whose Properties window you already have open.

To Inspect a junction connected to a given pipe, position the mouse
pointer on the connected junction's ID number in that pipe’s Properties
window (located at the top right of the Pipe Properties window) and
hold down the right mouse button. This process can be repeated for any
junctions that state the upstream and downstream pipe in the junction’s
Properties window by holding the right mouse button on the pipe’s ID
number.

By double-clicking the connected junction number, you can jump
directly to the junction's properties window, or you can click the Jump
button to jump to any other part of you model.

Wavespeed
The wavespeed is a very important parameter in waterhammer analysis.
The wavespeed can be calculated with reasonable accuracy from fluid
and pipe data, or it may be available from test data or industry
publications. If the wavespeed is not known (which is typical), then the
Calculated Wavespeed option is the preferred option. In this case, data is
required for pipe wall thickness, modulus of elasticity, Poisson Ratio,
and pipe support details. Data for pipe wall thickness, modulus of
elasticity, and Poisson Ratio are built into the pipe material libraries
supplied with AFT Impulse, and was automatically obtained when the
Steel - ANSI, 10-inch, STD (schedule 40) option was chosen. The
calculated wavespeed is 4328 feet/sec (see Figure 2.18). Click OK.

Enter data for other pipes
Similar to Pipe P1, enter the following data for the other pipes. Note that
all pipes will use the Thick-Walled Anchored Upstream Pipe Support
and the Standard Friction Model.

Pipe Size (inches) Length (feet)

1 10 200

2 10 150

3 12 50

4 12 40



Check pipes and junctions
Ø Check if all the pipes and junctions are defined. If all the pipes and

junctions are defined the Pipe and Junctions group in the Analysis Setup
window will have a green checkmark. If not, turn on the “Show Object
Status” from the View menu or Workspace Toolbar icon, and open each
undefined pipe and junction. The Status tab on each Properties window
will indicate what information is missing.

Review model data
Ø Save the model one more time. It is also a good idea to review the

input using the Model Data window.

Reviewing input in the Model Data window
The Model Data window is shown in Figure 2.19. To change to this
window, you can click on the Model Data tab, select it from the
Window menu, or press CTRL+M. The Model Data window gives you a
text-based perspective of your model. Selections can be copied to the
clipboard and transferred into other Windows programs, exported into
Excel, saved to a formatted file, printed to an AdobeTM PDF, or printed
out for review.

Data is displayed in three general areas. The top is called the General
data section, the middle is the Pipe data section and the bottom is the
Junction data section. Each section is collapsible using the buttons at the
top left of the section. Further, each section can be resized.

The Model Data window allows access to all Properties windows by
double-clicking on any input parameter column in the row of the pipe or
junction you want to access. You may want to try this right now.
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Figure 2.19 The Model Data window shows all input in text form

Steady State groups are now fully defined
The first three groups in Analysis Setup are now fully defined. If
desired, the model could be run in steady-state. The final two groups
that need to be defined are for transient modeling. To run the model in
steady-state, go to the Simulation Mode/Duration panel in Analysis
Setup and change the Time Simulation selection to Steady Only.

In general, it is a good idea to always run your model in steady-state
first before running the full transient analysis to make sure the model is
giving reasonable results.

D. Specify the Pipe Sectioning and Output group
The fourth group in Analysis Setup is the Pipe Sectioning and Output
group. The pipes in the model cannot be sectioned until sufficient data
in the Fluid Properties group and Pipe and Junctions group have been
specified. These required data include the fluid specification (this was
done in Step 3B when the Fluid panel was defined) and all pipes and



junctions definitions. After these data have been entered, the pipes can
be sectioned. The Sectioning panel divides the pipes into computation
sections in a manner which is consistent with the Method of
Characteristics (MOC).

Go to the Sectioning panel in Analysis Setup (Figure 2.20). The pipes
will automatically be sectioned and a controlling pipe will be selected.
For this model, the controlling pipe is P4. This is the pipe with the
shortest end-to-end communication time (i.e., L/a – the length divided
by the wavespeed). To satisfy the MOC, the following equation must be
applied:

where n is the number of sections in pipe i, L is the length, and a is the
wavespeed. The Δt is the time step. Since all pipes in the network must
be solved together, the same time step must be used for each pipe. With
a given length and wavespeed for each pipe, it can be seen from the
above equation that it is unlikely that the number of required sections, n,
for each pipe will be a whole number.

To address this situation, it is helpful to recognize that the wavespeed, a,
is the least certain input parameter. It is therefore generally considered
acceptable to allow up to a 15% uncertainty in wavespeed. By adjusting
the wavespeed for each pipe within this tolerance, the sectioning can be
made to come out as whole numbers for each pipe. The Sectioning panel
automates this process by searching for sectioning which satisfies the
required tolerance. While a 15% variance in wavespeed is often
acceptable, AFT Impulse uses 10% by default.
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Figure 2.20 The Pipe Sectioning panel automates the sectioning
process and calculates the time step

Ø Open Analysis Setup and go to the Sectioning panel.

When the Sectioning panel is first opened, it will automatically search
for the best option for one to five sections in the controlling pipe. The
results will be displayed in the table at the top. If more sections are
needed, you can change the “Search up to” quantity and click “Update
Results”.

In this example model, the results when the controlling pipe has only
one section show a maximum variance of 11%. Since this is greater than
the default 10% threshold (shown when the Advanced Settings section is
expanded), the first row is colored red and was not automatically
selected. The option to have two sections in the controlling pipe is



selected since that has the fewest sections with an acceptable maximum
variance. The time step is shown to be 0.004270 seconds.

Note that if the number of sections in the controlling pipe is doubled, the
runtime increases roughly by a factor of four (twice the number of
computations per time step and twice the number of time steps for the
run). In this example, selecting four sections in the controlling pipe
would result in the smallest variance in wavespeed modifications out of
the options displayed, but the runtime would be four times that
compared to the case where two sections are selected (16 times longer
than with one section in the controlling pipe). Remembering that it is
acceptable to have up to a 15% uncertainty in wavespeed, and that there
are other uncertainties in the model, one would typically pick the option
with the fewest sections with an acceptable maximum variance.

E. Specify the Transient Control group
The final group to be defined in Analysis Setup before the transient
solver can run is the Transient Control group. This group allows you to
specify the time at which the transient starts and ends, as well as the
cavitation and friction model to use in the calculations.

Ø Go to the Simulation Mode/Duration panel in Analysis Setup. Enter
2 seconds in the Stop Time field, as shown in Figure 2.21.

The Transient Cavitation panel allows you to enable or disable transient
cavitation modeling and select a model to use.

At the bottom of the window, the projected output file size is shown.
You should pay attention to this number, as the output file size can grow
very large. In this case, the output file will be 84 kB. If the output file
does become excessively large, you will want to limit the number of
time steps and pipe output written to disk. Note that the estimated file
size and computational time may vary between machines.

Ø Click OK to accept the current settings. All groups in Analysis Setup
should now be defined. The model is ready to be solved.
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Figure 2.21 The Simulation Mode/Duration panel offers features to
specify the time span for the transient

F. Save the model
Saving the model immediately before running it is always a good idea.
Ensure that you save your model now.

Step 4. Run the solver
Ø Choose “Run Model…” from the Analysis menu or click the Run

Model button on the Toolbar. During execution, the Solution Progress
window is displayed (Figure 2.22). You can use this window to pause or
cancel the Solver's activity.



Figure 2.22 The Solution Progress window displays the state of
the simulation

A. The two solvers
AFT Impulse has two Solvers. The first is called the Steady-State
Solver, which as its name suggests, obtains a steady-state solution to the
pipe network. The second Solver is called the Transient Solver. This
solves the waterhammer equations.

Before a transient simulation can be initiated, the initial conditions are
required. These initial conditions are the steady-state solution to the
system. After the steady-state solution is obtained by the Steady-State
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Solver, AFT Impulse uses the results to automatically initialize the
Transient Solver and then run it.

When the solution is obtained, click the Output button on the Solution
Progress window to display the text-based Output window. The
information in the Output window can be reviewed visually on the
screen, saved to file, exported to a spreadsheet-ready format, copied to
the clipboard, and printed out.

B. The transient output file
When the Transient Solver runs, the transient output data is written to a
file. This file is given the same name as the model itself with a number
appended to the name, and with an “.out” extension appended to the
end. For all transient data processing, graphing, etc., the data is extracted
from this file. The number is appended because AFT Impulse allows the
user to build different scenarios all within this model. Each scenario will
have its own output file; thus, the files need to be distinguishable from
each other.

The output file will remain on disk until the user erases it or the input
model is modified. This means that if you were to close your model
right now and then reopen it, you could proceed directly to the Output
window for data review without rerunning your model.

Step 5. Review the Output window

The Output window (Figure 2.23) is similar in structure to the Model
Data window. Three areas are shown (including the General section,
Pipe Section, and Junction section), and you can expand or collapse
each section by dragging the boundary between the sections up or down,
or by clicking the arrow beside the section label. The items displayed in
the tables are those items you select in the Output Control window.

The Output window allows you to review both the steady-state and
transient results. The Pipes tab, All Junctions tab, and any specific
junction tabs in the Junction section (such as Branch, Reservoir, Valve,
etc.) show the steady-state results. A summary of the maximum and
minimum transient results for each pipe is given on the Transient
Max/Min tab in the Pipe section and is the active tab displayed in the
center section of Figure 2.23.



Figure 2.23 The Output window displays steady and transient
output in text form

You can also review the solutions for each time step (i.e., a time history)
for which data was written to file on the Transient Output tab in the Pipe
section (Figure 2.24). Moving the slider along the bottom will change
the time step shown in the table.

The Output Control window (Figure 2.25) allows you to select the
specific output parameters you want to display in your output. You also
can choose the units for the output. If you do not change any of the
Output Control settings, default Output Control parameters and a default
title are assigned.
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Figure 2.24 The Output window displays transient data for each
time step in the Transient Output table

Figure 2.25 Output Control lets you customize the output



Units for each column in the Output section can also be changed by
double-clicking the column header. This will open a window in which
you can select the units again if you prefer (Figure 2.26). These
changes are extended to the Output Control parameter data that is set.

Figure 2.26 The Change Units window is opened from the Output
window tables by double-clicking the column header

Step 6. View the graph results

For transient analyses, the Graph Results window will usually be more
helpful than the Output window because of the more voluminous data.

AFT Impulse’s Graph Guide feature, accessed by clicking on the “What
Would You Like to Do?” button located at the top right of the Graph
Area, provides assistance by guiding you through the creation of a
“Quick and Simple” graph, or an “Advanced” graph (Figure 2.27). You
can create a graph by following the prompts on the Graph Guide, or by
manually specifying the graphing parameters on the Graph Control tab
on the Quick Access Panel, or from the “Select Graph Parameters” icon
located in the top left corner of the Graph Results Toolbar. For the
remainder of this Quick Start Guide, the Graph Guide will be hidden,
but keep in mind that you can use it whenever you would like assistance
in creating a graph.

Figure 2.28 shows the Graph Results window with the Graph Control
tab enabled on the Quick Access Panel.

42 AFT Impulse™ 9 Quick Start Guide



Chapter 2 Valve Closure Example 43

Figure 2.27 The Graph Guide can be toggled on and off by
clicking the “What Would You Like to Do?” button on
the Graph Results window

Figure 2.28 The Graph Results window and Quick Access Panel
Graph Control tab is where system parameters (both
steady-state and transient) can be graphed

AFT Impulse gives you the ability to create “stacked graphs”. These are
graphs that are displayed on top of each other with the same X-axis but
with different parameters on the Y-axis. This feature is helpful to see
how multiple parameters change in the same location of your model at
the same time without having to create separate graphs.



In this example, you will create stacked graphs of the pressures and
flows at the inlet and outlet of Valve J4 to see how these parameters
change as the valve closes.

Ø First, change to the Graph Results window by clicking on the Graph
Results tab, by clicking “Graph Results” from the Solution Progress
window after running the model, or by pressing CTRL+G. The Graph
Results window offers full-featured Windows plot preparation. 

Ø Access the graphing parameters by opening the Graph Control tab
on the Quick Access Panel (this tab is automatically selected when
the Graph Results window is opened). Because you are interested in
seeing how the pressures and flows in specific pipe sections respond
over time, ensure that the Transient Pipe tab is selected in the
Parameters/Formatting area on the Quick Access Panel. Alternatively,
you can open the Select Graph Parameters window by clicking on the
corresponding icon on the Graph Results Toolbar (this is the first icon
located above the top left corner of the Graph area).

Ø Under “Select Pipe Stations” on the Transient Pipe tab, expand the
P3 pipe stations and double-click on Outlet, which is the pipe
computing station at the valve inlet. Alternatively, you can click on the
right arrow button after selecting the pipe station you want to graph to
add it to the “Graph These Pipes/Stations” list. Also add the inlet of Pipe
P4 which is the valve exit.

Note: Once a pipe is broken into sections, computation takes place
where the sections join together, these are called "stations".

Ø Select seconds for the Time Units and select “All Times” next to
“Time Frame”.

Ø In the Parameters definition area, select “Pressure Static” and
choose “psig” in the dropdown box under “Units” to graph the static
pressure in barG at the valve inlet and outlet over time.

Ø In order to add the stacked graph under the static pressure graph
showing the volumetric flowrate at the inlet and outlet of Valve J4,
click the “Add” button, which has the green “+” icon next to “Select
Parameter”. A new row under the Parameter definition area will appear
(See Figure 2.29).
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Ø Choose “Volumetric Flowrate Upstream” in this new parameter
row and select units of “gal/min”.

Ø Click Generate at the bottom of the Quick Access Panel to create the
static pressure and volumetric flowrate graphs at the inlet and outlet of
the valve over the duration of the simulation.

Ø To format the legend font size, right-click on each legend and use
the scroll bar to decrease the font size to 14 for both graphs. Drag the
legend to the upper right corner of the graph.

Ø To format each axis font size, right click on each axis title and use
the scroll bar to decrease the size until the font size on each axis
appears as you want it.

Figure 2.29 shows the input in the Parameters/ Formatting area on the
Quick Access Panel.

Figure 2.29 The Graph Control tab on the Quick Access Panel
allows you to specify the graph parameters you want
to graph in the Parameters/Formatting area



Figure 2.30 shows the stacked graphs detailing the static pressures and
volumetric flowrates at the Valve J4 inlet and outlet over two seconds.
Here you can see that the maximum pressure at the valve inlet is about
60 psig. It should be noted that these graphs could also be made from
the Transient Jct tab. In this case, the inlet and outlet pressures at the
valve would be selected separately.

Figure 2.30 The Graph Results window offers full-featured plot
generation. Here the static pressure and volumetric
flow at the Valve J4 inlet and outlet are shown over 2
seconds.

The graph colors, fonts and other elements can be modified using the
Formatting area on the Graph Control tab on the Quick Access Panel. 
The Graph Results window can be printed, saved to file, copied to the
clipboard, or printed to an Adobe PDF file. The graph’s x-y data can be
exported to file or copied to the clipboard.

A. Further review
Further review of the valve graph results in Figure 2.30 shows that at
time zero, the pressure difference between the top and bottom curves of
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the pressure graph is about 16 psid. This is the steady-state pressure
difference across the valve, which can also be found in the Output
window to be 15.69 psid.

As time increases, one sees that the two curves move further apart,
which represents the increased pressure drop across the valve as it
closes. At one second, the valve closes entirely and the pipes upstream
and downstream of the valve are isolated from each other and will decay
to the steady-state conditions which exist for a closed valve.

For the purpose of analysis, it would also be useful to view the
volumetric flow rate from each supply tank over time.

Ø Create a new graph tab by clicking the “New Tab” button which is the
green plus icon located on the bottom right, immediately below the
graph area (Figure 2.31)

Ø Open the Transient Pipe tab on the Graph Control tab of the Quick
Access Panel. Add the P1 and P2 inlet pipe stations to the “Graph These
Pipes/Stations” list and remove P3 outlet and P4 inlet pipe stations.

Ø Select “seconds” in the Time Units section and “All Times” in the
Time Frame section to graph the volumetric flowrate over the entire
simulation duration.

Ø Select Volumetric Flowrate Upstream and specify the units as
“gal/min”.

Ø Click the Generate button to display the graph. A graph of these
stations shows the flowrates out of the two supply reservoirs. Note that
after the valve closes, the fluid in Reservoir J1 flows to Reservoir J2
(Figure 2.31).



Figure 2.31 Transient flowrates out of the reservoirs

Note: AFT Impulse allows you to quickly generate several types of
graphs by right-clicking on pipes or junctions on the Workspace after
your model has output. To quickly generate the static pressure plot at the
Valve J4 inlet and outlet, you can right-click on Valve J4 on the
Workspace, then select “Generate Transient Graph for Pipes”, then
select Pressure Static. To add the volumetric flowrate stacked graph, or
to modify any units or other graph parameters, access the Graph Control
tab on the Quick Access Panel and adjust the graph parameters as
desired. 
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Step 7. View the Visual Report

The Visual Report allows you to show text output alongside the model
schematic. This is useful to quickly show pertinent information in
relation to the location in the model. The Visual Report can also animate
the transient pipe results in a color animation overlaid on the model.

Ø Change to the Visual Report window by clicking on the Visual Report
tab, choosing it from the Window menu, or pressing CTRL+I. This
window allows you to integrate your text results with the graphic layout
of your pipe network. The Visual Report Control window will
automatically open when accessing the Visual Report window for the
first time. Visual Report Control can also be opened from the Toolbar or
the Tools menu.

Ø Select “Max Pressure Stagnation” and “Min Pressure Stagnation”
in the Pipe Results area as shown in Figure 2.32. Click the Show button.
The Visual Report window graphic is generated (Figure 2.33).

It is common for the text in the Visual Report window to overlap when
first generated. You can change this by selecting smaller fonts or by
dragging the text to a new area to increase clarity. You can also use the
Visual Report Control window to display units in a legend to increase
the clarity of the display.  These adjustments have already been done in
Figure 2.33. This window can be printed or copied to the clipboard for
import into other Windows graphics programs, saved to a file, or printed
to an Adobe PDF file.

The Visual Report window also provides the ability to animate the
transient results as a qualitative tool to visualize the behavior in a
network. This option can also be accessed from the Visual Report
Control by selecting the Animate Display Mode at the top of the
window (see Figure 2.32). When using the animation mode, text results
cannot be displayed for the report. Instead, one parameter can be
animated using absolute values, values relative to the steady state, or a
static map of all maximum/minimum transient values can be generated.
The animation can be recorded to a file. The model setup for animating
static pressure can be seen in Figure 2.34.



Figure 2.32 The Visual Report Control window selects content for
the Visual Report window
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Figure 2.33 The Visual Report integrates results with model layout



Figure 2.34 The Visual Report provides an animation feature as an
alternate way to view the transient results

Conclusion

The maximum pressure at the valve’s inlet during this valve closure is
approximately 75 psia. You have now used AFT Impulse's five Primary
Windows to build a simple waterhammer model.

52 AFT Impulse™ 9 Quick Start Guide



C H A P T E R 3

Pump Startup with Event Transients

This example looks at three pump startup cases for a water transfer
system. The objective is to determine the maximum pressures in the
system and to assess whether the system cavitates or experiences sub-
atmospheric pressure.

Topics covered
l Starting one or more pumps

l Using steady-state and transient special condition features

l Using event transients

l Using Scenario Manager

l Adding Graphs to the Graph List Manager

l Using Graph Animation

Required knowledge

These examples assume that the user has some familiarity with AFT
Impulse such as placing junctions, connecting pipes, and entering pipe
and junction properties. Refer to Valve Closure Example in Chapter 2
for more information on these topics.



Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT Impulse installation:
l US - Pump Startup with Event Transients.imp

Problem statement

This problem contains two pumps in parallel that transfer water from a
supply reservoir to two process tanks downstream. The following three
different pump startup scenarios are to be modeled and evaluated:
1. Both pumps starting

2. One pump starting

3. One pump starting with the other pump already running

As the design engineer, you will evaluate these three scenarios to
determine the maximum and minimum system pressures, as well as use
the animation features in AFT Impulse to understand how the system
will respond in each case.

Step 1. Start AFT Impulse

From the Start Menu choose AFT Products and AFT Impulse.

Step 2. Define the Fluid Properties group
1. Open Analysis Setup using the button on the toolbar or from the

Analysis menu.
2. Open the Fluid panel, select the AFT Standard library, then select

Water (liquid) from the “Fluids Available in Library” list.
3. Click "Add to Model" to select water for use in this model.

4. Enter 60 deg. F in the Temperature field. This calculates the fluid
properties to use in the model.

5. Click OK.
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Note: The fluid can also be specified in the Startup window when AFT
Impulse is first opened.

Step 3. Define the Pipes and Junctions group

At this point, the first two groups are completed in Analysis Setup. The
next group is the Pipes and Junctions group.

A. Place the pipes and junctions
In the Workspace window, assemble the model as shown in Figure 3.1.
The Add/Remove Segments button on the Toolbar can be used to create
the bend in pipes P4 and P6. Segments are only visual, and do not affect
calculations.

Figure 3.1 Layout of pipe system for pump startup example

B. Enter the pipe and junction data
The system is in place, but now the input data for the pipes and
junctions need to be entered. Double-click each pipe and junction and



enter the following data in each Pipe and Junction Properties window.

Pipes
All pipes are Steel – ANSI, STD, Thick-Walled Anchored Upstream,
and Standard Friction Model with the following properties:

Pipe Name Size
(inches)

Length
(feet)

1 Suction Pipe Pump #1 10 50

2 Discharge Pipe Pump #1 10 20

3 Pipe 10 20

4 Suction Pipe Pump #2 10 60

5 Discharge Pipe Pump #2 10 20

6 Pipe 10 20

7 Pipe 16 100

8 Line to Process #1 Tank 12 250

9 Line to Process #1 Tank 12 200

10 Line to Process #1 Tank 12 1200

11 Line to Process #2 Tank 12 5000

J1 - Reservoir
1. Name = Supply Reservoir

2. Tank Model = Infinite Reservoir

3. Liquid Surface Elevation = 20 feet

4. Liquid Surface Pressure = 0 psig

5. Pipe Depth = 20 feet
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J10 - Reservoir
1. Name = Process #1 Tank

2. Tank Model = Infinite Reservoir

3. Liquid Surface Elevation = 100 feet

4. Liquid Surface Pressure = 0 psig

5. Pipe Depth = 10 feet

J11 - Reservoir
1. Name = Process #2 Tank

2. Tank Model = Infinite Reservoir

3. Liquid Surface Elevation = 10 feet

4. Liquid Surface Pressure = 0 psig

5. Pipe Depth = 10 feet

J6, J7, & J8 - Branches
1. Elevation = 0 feet

J2 & J4 - Pumps
1. J2 Name = Transfer Pump #1

2. J4 Name= Transfer Pump #2

3. Inlet Elevation = 0 feet

4. Pump Model = Centrifugal (Rotodynamic)

5. Enter Curve Data =

Volumetric Head

gal/min feet

0 150

1000 140

2000 120



6. Curve Fit Order = 2

7. Click Generate Curve Fit Now then click OK

8. Click the Transient tab

9. Transient = Speed vs. Time

10. Transient Data = Absolute Values

Time
(seconds)

Pump Speed
(Percent)

0 0

2 100

10 100

11. Click the Optional tab

12. Special Condition = Pump Off With Flow Through

Note: The pump special condition indicates that initially the pump is
turned off, but flow can go through it during steady-state. Valve
junctions will be used to prevent any steady-state flow, as mentioned
earlier. The pump junction in the Workspace will now have a red ‘X’
next to it indicating that the special condition is set to closed.

J3 & J5 - Valves
1. J3 Name = Valve #1

2. J5 Name = Valve #2

3. Inlet Elevation = 0 feet

4. Cv = 1000

5. Click the Transient tab

6. Transient Data = Absolute Values
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Time
(seconds) Cv

0 0

1 800

2 1000

10 1000

7. Click the Optional tab

8. Special Condition = Closed

Note:When you close the valves, the adjacent pipes are displayed with
dashed lines to denote that the pipes will have no flow.

J9 - Valve
This valve will use an event transient. This means that the time zero in
the Transient Data table is with respect to a condition occurring in the
system. If the condition is never reached, the valve transient never
initiates. Here, the valve should open when the pressure at Branch J7 is
sufficient for water to flow into Reservoir J10. There is no "Junction
Pressure" for the “Initiation of Transient”, but there is one for pipes. Use
one of the pipes connected to Branch J7 as a basis for the event.
1. Name = Valve to Process #1 Tank

2. Inlet Elevation = 0 feet

3. Cv = 500

4. Click the Transient tab (Figure 3.2)

5. Initiation of Transient = Single Event

6. Event Type = Pressure Stagnation at Pipe

7. Condition = Greater Than

8. Value = 45 psig

9. Pipe = 7 (Pipe) Outlet

10. Transient Data = Absolute Values



Time
(seconds) Cv

0 0

2 400

3 500

10 500

Figure 3.2 Specifying an event transient for Valve J9
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11. Click the Optional tab

12. Special Condition = Closed

Note: Transients which have multiple event initiators can be defined
using Multi-Condition events, which are defined by selecting Multi-
Condition for the Event Type, then using the Multi-Condition Event
Manager to group the events.

C. Check if the pipe and junction data is complete
Turn on “Show Object Status” from the toolbar or View menu to verify
if all data is entered. If so, the Pipes and Junctions group in Analysis
Setup will have a check mark. If not, the pipe or junction number of any
uncompleted pipes or junctions will be shown in red. If this happens, go
back to the uncompleted pipes or junctions and enter the missing data.

Note: Red is the default color that shows what objects are undefined in
your model when Show Object Status is active. This color is
configurable in the User Options.

Step 4. Specify the Pipe Sectioning and Output group

Open Analysis Setup and go to the Sectioning panel. When this panel is
first opened, it will automatically search for the best (least number of
sections within 10% variance) option for one to five sections in the
controlling pipe. The results will be displayed in the table at the top. No
input is required for this step.

To minimize run time and output file size, the table on the Output Pipe
Station panel uses “Inlet and Outlet” for all pipes by default. This will
cause the output for only the inlet and outlet station of each pipe to be
saved to file. Data can be saved for all pipe stations or only selected
stations. Click the All button to select all the pipes in the table. Drop
down the list next to the “Change Selected Pipes To” button and select
“All Stations”. Then click the “Change Selected Pipes To” button
(Figure 3.3). This will save all pipe station data for all pipes, which will
be useful later for animation purposes.



Figure 3.3 Output Pipe Sections panel with All Stations selected
for all pipes

Step 5. Specify the Transient Control group

Go to the Simulation Mode/Duration panel in the Transient Control
group and enter a Stop Time of 10 seconds.

Next, go to the Transient Cavitation panel and clear the checkbox for
Model Transient Cavitation (cavitation will be ignored until it becomes
clear that it should be modeled)

Step 6. Create scenarios to model the three startup cases

In this model, the following three pump startup cases are to be
evaluated:
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1. Both pumps starting

2. One pump starts while the other pump stays off

3. One pump starts while the other is already running

Three scenarios need to be created to model the three cases.

A. Create scenarios
The Scenario Manager is a powerful tool for managing variations of a
model, referred to as scenarios. The Scenario Manager allows you to:
l Create, name and organize scenarios

l Select the scenario to appear in the Workspace (the ‘current’
scenario)

l Delete, copy and rename scenarios

l Duplicate scenarios and save them as separate models

l Review the source of a scenario’s properties

l Pass changes from a scenario to its variants

You will create three scenarios to model these cases. Scenarios are
created using the Scenario Manager from the Tools menu or the
Scenario Manager on the Quick Access Panel. The Quick Access Panel,
located on the right side of the Workspace area, contains the Scenario
Manager on the Scenario tab. A scenario tree displays all model
scenarios.

Click the "Create Child" button on the Scenario Manager on the Quick
Access Panel. Name the child “Two Pump Start.” A new scenario will
appear below the Base Scenario in the scenario tree. Select the Base
Scenario, create another child, and call it “One Pump Start.” Finally,
create a third child called “One Pump Start With One Running” (see
Figure 3.4). Note that the new child scenario is loaded when it is created
using the Scenario Manager on the Quick Access Panel.



Figure 3.4 The Scenario Manager on the Quick Access Panel
displays the scenario tree that allows you to create
model variants (scenarios) and keep them organized
within the same model file

B. Set up scenarios
Child scenarios “inherit” data from their ancestors. As long as the data
has not been modified in a child scenario, data parameters in the child
scenario will have the same value as their parent.

Two Pump Start
Since the Base Scenario already has been setup with two pumps starting,
the “Two Pump Start” child does not need to be modified.

One Pump Start
Double-click the “One Pump Start” scenario in the scenario tree of the
Scenario Manager on the Quick Access Panel. This will load the “One
Pump Start” scenario onto the Workspace as the current scenario. The
currently loaded scenario is displayed in the scenario tree with a green
check mark (Figure 3.4).

Here, only Pump J2 will be started while keeping Pump J4 off. Deleting
the transient input data for Pump J4 and Valve J5 will keep these two
junctions turned off because their Special Conditions specify that they
are off. Alternatively, their transient data can be set to be ignored. The
second option is what will be done here.
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Ø Open the J4 Pump Properties window. Click on the Transient tab,
then choose the “Ignore Transient Data” option in the “Transient Special
Condition” area as shown in Figure 3.5 then click OK. Note that a red
‘#’ will now be shown next to junction J4 indicating that the transient
data is ignored. Do the same with the J5 Valve. The required input for
this scenario is now complete.

Figure 3.5 Transient Special Condition section on the Transient
tab of the Pump Properties window

One Pump Start with One Running
Double-click the “One Pump Start With One Running” scenario from
the scenario tree in the Scenario Manager on the Quick Access Panel.
This will load the “One Pump Start With One Running” scenario onto
the Workspace as the current scenario. This step can also be
accomplished by opening the Scenario Manager from the Tools menu,
selecting the “One Pump Start With One Running” scenario in the
scenario tree and then clicking the “Load As Current Scenario” button.

Here, Pump J2 will be running at 100% speed during the steady-state
and transient, and Pump J4 will be started.

Ø Open the J2 Pump window and select the Optional tab. Set the Special
Condition to “None”. This specifies that during the steady-state the
pump will be on and operate on its curve.



Ø Select the Transient tab and set the Transient Special Condition to
“Ignore Transient Data”, since this pump will run at 100% speed during
the transient. Alternatively, the speed data could be deleted.

The Special Condition for Valve J3 also needs to be set to “None”, and
the Transient Special Condition on the Transient tab set to “Ignore
Transient Data” by following the two steps above in the J3 Valve
Properties window. The required input for this scenario is now
complete.

Step 7. Run the model

Load the "Two Pump Start" scenario. All groups in Analysis Setup
should now be complete and the model ready to run. Run the model by
pressing the “Run Model” icon on the Workspace Toolbar, selecting
“Run Model” in the Analysis menu, or pressing CTRL+R on the
keyboard. The Waterhammer Assistant window may pop up when the
model is run. This window is a tool which provides advice to help
simplify and improve the model before it is run. Click OK to dismiss the
window. This will open the Solution Progress window. When complete,
press the “Graph Results” button.

Step 8. Graph the results

First a profile graph will be created to show the static pressure across
the length of a series of pipes.

A. Create a profile graph
1. From the Graph Control tab on the Quick Access Panel, select the

Profile tab.
2. Select pipes 1, 2, 3, 7 and 11 to specify the path from the supply

reservoir to Reservoir J11. Alternatively, you can select all these
pipes on the Workspace by holding SHIFT while clicking on all
pipes in the path, then return to the Graph Results tab and select
“Workspace” to automatically choose all pipes currently selected
on the Workspace.

3. Use “feet” for the Length Units.
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4. In the Parameters definition area, use “Pressure Static” and specify
“psig” in the dropdown box under “Units”.

5. Ensure that the boxes in the Mx and Mn columns are selected
(these indicate that your graph will display the maximum and
minimum pressures, respectively).

6. Click Generate.

Results (shown in Figure 3.6) indicate that the peak pressure occurs at
the pump discharge, and that the minimum pressure is above
atmospheric pressure at all times.

The “Show Junction Locations” icon shows the locations of junctions
along the selected flow path.

Figure 3.6 Profile of the maximum and minimum pressures
through Pump #1 to Process #2 Tank for Two Pump
Start scenario



To easily recreate this graph in other scenarios or in the future, it can be
added to the Graph List. This can be done using the Graph List Manager
on the Quick Access Panel. After generating the graph, click the “Add
Graph To List” button on the Graph Results Toolbar (this icon is a blue
“+” sign on top of a file folder image). Give the graph a name like
“Pressure Profile Pump #1 to Process #2 Tank”. The graph will be
added to the currently selected folder in the Graph List Manager. Note
that graphs added to the Graph List Manager are not permanently saved
until the model itself is saved again.

The profile through the other flow paths (there are four paths altogether)
can also be plotted, and similar conclusions are obtained. Add the other
three paths to the Graph List.

B. Create a Transient Junction graph
Since the maximum pressure is at the pump discharge, it is of interest
here to plot the pressure vs. time. The volumetric flowrate vs. time at the
pump discharge is also of interest. You will use AFT Impulse’s dual Y-
axis graphing abilities to plot both the pressure and volumetric flow rate
vs. time on the same graph to observe how the pressure and flow change
at the same time.
1. From the Graph Control tab, choose the Transient Jct tab in the

Parameters/Formatting area and add pumps J2 and J4 to the “Graph
These Junctions” list.

2. Ensure that the Time Units is set to “seconds” and the Time Frame
is set to “All Times”.

You will need to decide what parameter you wish to plot on the primary
Y-axis and which parameter you want to plot on the secondary Y-axis.
In this example, we will plot pressure on the primary Y-axis and
volumetric flowrate on the secondary Y-axis.
3. To do this, select “Pressure Static Outlet” in the Parameters

definition area and choose “psig” as the units.
4. Add a parameter by clicking on the “Add” button next to “Select

Parameter” in the Parameter definition area.
5. Change this added parameter to “Vol. Flow Rate Outlet” and

choose “gal/min” as the units.

68 AFT Impulse™ 9 Quick Start Guide



Chapter 3 Pump Startup with Event Transients 69

6. To specify that the volumetric flowrate will be plotted on the
secondary Y-axis, click the “Make Secondary Y-Axis” button,
which is the blue, right arrow icon located to the top right over the
selected parameters. Alternatively, you can double-click on the
column in front of “Volumetric Flowrate” in the Parameter
definition area. Note that “Vol. Flow Rate Outlet” becomes
indented under “Pressure Static Outlet”, and that the black arrow
next to “Vol. Flow Rate Outlet” turns to point towards the graph.
See Figure 3.7 to see how these graphing parameters are defined.

Figure 3.7 Parameter definitions for dual Y-axes graph of static
pressure (primary Y-axis) and volumetric flowrate
(secondary Y-axis) on the Graph Control tab on the
Quick Access Panel

Click Generate. You will see that the transient pressures at the pump
discharge are plotted versus time on the primary Y-axis, and the
volumetric flowrate vs. time is plotted on the same graph on the
secondary Y-axis. As would be expected, the pressure and volumetric



flowrate transients are very similar for both pumps. The resulting graph
is shown in Figure 3.8. Add this graph to the Graph List.

Figure 3.8 Pressure and volumetric flowrate transients at both
pump discharge locations for Two Pump Start
scenario

C. Create a Transient Pipe graph
The flowrates into the two process tanks are of interest.
1. Go to the Transient Pipe tab on the Graph Control tab.

2. Add the outlet of Pipes P10 and P11 from the “Select Pipe
Stations” list to the “Graph These Pipes/Stations” list.

3. Select “Volumetric Flowrate” from the Parameter list.

4. Choose units of gal/min

5. Click Generate.

Results are shown in Figure 3.9. Add this plot to the Graph List.
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Figure 3.9 Flowrate transient at both process tanks for Two
Pump Start scenario

Step 9. Animate the results

AFT Impulse can animate hydraulic parameters along pipeline paths in
your model in the Graph tab. This feature is very helpful when trying to
understand how your system will respond when a transient event occurs.
You can also animate multiple graphs at the same time.

Here, you will animate the pressure and volumetric flowrate responses
along the path you previously graphed to gain an understanding of how
these hydraulic parameters respond as the pumps start up. To animate
these parameters:
1. Select the Profile tab under the Graph Control tab on the Quick

Access Panel. Alternatively, you can access the Select Graph
Parameters window by clicking on the “Select Graph Parameters”
icon located at the top left of the Graph Results window.

2. Make sure pipes 1, 2, 3, 7, and 11 are selected



3. Add a second parameter in the Parameters definition area, then
specify one parameter to be “Pressure Static” and the other to be
“Volumetric Flowrate”.

4. As was done in Step 8, specify that the volumetric flowrate will be
plotted on the secondary Y-axis by double-clicking on the column
in front of “Volumetric Flowrate” in the Parameters definition area.
Note that “Volumetric Flowrate” becomes indented under “Pressure
Static”, and that the black arrow next to “Volumetric Flowrate”
turns to point towards the graph (Figure 3.10)

Note: AFT Impulse provides the flexibility to simultaneously animate
stacked graphs, as well as graphs with dual Y-axes plotted. In this
example, you will animate the static pressure and volumetric flowrate
displayed on dual Y-axes.

5. Use the Length Units of feet

6. Next to Animate Using, specify “Output”, and specify “seconds”
next to Animation Time Units (see the following paragraph for an
explanation about this option)

7. Change the pressure units to psig and the volumetric flowrate units
to gal/min

8. Specify for both the static pressure and volumetric flowrate graphs
that you want to see the maximum and minimum values plotted
along the length of the graphed path by placing a checkmark in the
boxes in the Mx and Mn columns next to each parameter (See
Figure 3.10)

To use the “Animate Using: Output” option for animation, all pipe
stations need to be specified to be saved in the Output Pipe Stations
panel in the Pipe Sectioning and Output group (this was done previously
in Step 4). This animation option has the most flexibility to start, pause,
and restart animation.

Another animation option in Figure 3.10 is “Animate Using: Solver”.
This option reruns the Transient Solver to generate the data for
animation, and thus does not need to read it from file. Therefore, it does
not require all of the pipe station data to be saved in Transient Control.
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Figure 3.10 Selecting animation in Graph Results for Two Pump
Start scenario

Click Generate. Additional animation control features appear on the
Graph Results window (Figure 3.11). Press the Play button and watch
the pressure waves and volumetric flowrate responses move between the
maximum and minimum values. This animation can also be recorded to
a file.

Step 10. Run the other scenarios and graph the results

Using Scenario Manager, load the other two scenarios and run them.
Reload the graph settings saved in Step 8 for the new scenarios by
double-clicking the graph names in the Graph List Manager. This will
reveal that the maximum pressure for the “One Pump Start” scenario
occurs at the pump discharge location, similar to the first scenario, but



in the “One Pump Start With One Running” scenario, the maximum
pressure occurs in Pipe P11. Also, the pressure drops below atmospheric
pressure, but does not reach the vapor pressure of water (-14.4 psig).

Figure 3.11 Animating output in Graph Results for Two Pump
Start scenario

In the “One Pump Start With One Running” scenario, it should also be
noted that there is a warning given for the pump. This is indicated by the
red message in the status bar. The warning can be viewed in the top
third section of the Output window on the Warnings tab, and states that
there was flow at pump junction J5. This warning message indicates that
there was insufficient information available to accurately calculate the
pump head with backwards flow. It is recommended to adjust the model
to better account for this flow.

Depending on the system, there are several actions that may be
appropriate. One change may be to adjust model inputs such as the
discharge valve opening profile to prevent reverse flow to the pump.
This is only acceptable if the changes are physically accurate for the
system. Otherwise, it will be necessary to choose an appropriate four
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quadrant data set for the pump to accurately predict the head at reverse
flow conditions. This will be discussed further in the next chapter.

Conclusion

The numerical maximum pressure can be found at the bottom of the
General data section in the Output window of each scenario and is
summarized in Table 3.1 for all three scenarios. For these cases, the
maximum pressures do not significantly differ from each other.

Table 3.1 Summary of maximum static pressure for the three
cases

Case
Max. Static
Pressure
(psig)

Two Pumps
Start 72.899

One Pump
Start 71.656

One Pump
Start With
One On

73.531
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Pump Trip Example

This example evaluates two parallel pumps tripping in a cooling tower
system. Various discharge valve closure times are analyzed to examine
the impact on the system when the valves close quickly enough to
prevent reverse flow at the pump, and when the valves do not close
completely before reverse flow occurs in the pump.

Topics covered
l Specifying a pump and power curve

l Using one of the transient pump inertia models

l Using Four Quadrant Data to model reverse flow and reverse
rotation in the pump.

Required knowledge

These examples assume that the user has some familiarity with AFT
Impulse such as placing junctions, connecting pipes, and entering pipe
and junction properties. Refer to Valve Closure Example in Chapter 2
for more information on these topics.



Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT Impulse installation:
l US - Pump Trip With Backflow - Four Quadrant Modeling.imp

Problem statement

In this problem, two parallel pumps in a cooling tower system lose
power, causing the pumps to trip. It is desired for the valves at the
discharge of the pumps to close quickly enough to prevent reverse flow
and rotation in the pumps. You will evaluate the maximum and
minimum pressures experienced in the system during this pump trip
event.

Furthermore, you will look at the case where the minimum valve closure
time is 12 seconds, in which case reverse flow and rotation will occur at
the pump.

Step 1. Start AFT Impulse

From the Start Menu choose AFT Products and AFT Impulse.

Step 2. Define the Fluid Properties group
1. Open Analysis Setup using the button on the toolbar or from the

Analysis menu.
2. Open the Fluid panel, select the AFT Standard library, then select

Water (liquid) from the “Fluids Available in Library” list.
3. Click "Add to Model" to select water for use in this model.

4. Enter 100 deg. F in the Temperature field. This calculates the fluid
properties to use in the model.

5. Click OK.
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Step 3. Define the Pipes and Junctions group

At this point, the first two groups are completed in Analysis Setup. The
next group is the Pipes and Junctions group.

A. Place the pipes and junctions
In the Workspace window, assemble the model as shown in Figure 4.1.
Note that the spray discharge junctions can be rotated as shown by
selecting the junctions in the Workspace and clicking the “Rotate
Icons…” button on the Workspace Toolbar.

Figure 4.1 Workspace for pump trip with backflow example



B. Enter the pipe and junction data
The system is in place, but now the input data for the pipes and
junctions need to be entered. Double-click each pipe and junction and
enter the following data in each Pipe and Junction Properties window.

Pipes
All pipes are Steel - ANSI, STD Type, Standard Friction Model, with
Thick-Walled Anchored Upstream Pipe Support.

Pipe Name Size
(inches)

Length
(feet)

1 Pipe 18 40

2 Pipe 18 40

3 Main Supply 30 325

4 Main Return 30 35

5 CWP-1 Suction 20 10

6 CWP-1 Discharge 20 10

7 Pipe 20 10

8 CWP-2 Suction 20 10

9 CWP-2 Discharge 20 10

10 Pipe 20 10

11 CT Return 30 400

12 Pipe 20 40

13 Pipe 20 40
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J1 & J2 - Reservoirs
1. J1 Name = CT #1 Basin

2. J2 Name = CT #2 Basin

3. Tank Model = Infinite Reservoir

4. Liquid Surface Elevation = 40 feet

5. Liquid Surface Pressure = 0 psig

6. Pipe Depth = 4 feet

J3 - Branch
Elevation = 35 feet

J4 - General Component
1. Name = Surface Condenser

2. Inlet Elevation = 0 feet

3. Loss Model = Resistance Curve

4. Enter Curve Data =

Volumetric Head

gal/min feet

0 0

20,000 22

40,000 88

J5 & J10 - Branches
Elevation = 0 feet

J11 - Branch
Elevation = 50 feet



J6 & J8 - Pumps
1. J6 Name = CWP-2

2. J8 Name = CWP-2

3. Inlet Elevation = 0 feet

4. Pump Model = Centrifugal (Rotodynamic)

5. Performance Curve Used in Simulation = Standard Pump Curve

6. Enter Curve Data =

Volumetric Head Power

gal/min feet hp

0 112 105

2,000 108 130

4,000 104 160

6,000 98 190

8,000 90 210

10,000 78 220

12,000 60 210

7. Curve Fit Order = 2

8. Rated Pump Speed = 1790 rpm

9. Click the Transient tab

10. Transient = Trip

11. Initiation of Transient = Single Event

12. Event Type = Time Absolute

13. Condition = Greater Than or Equal To

14. Value = 0 seconds
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15. Total Rotating Inertia = User Specified

16. Value = 140 lbm-ft2

Note:When reverse flow occurs at the pump, the Four Quadrant Model
is recommended to obtain a better estimate for the head at reverse flow.
To simplify the input, we will define the pump with the Standard Pump
curve for now (Figure 4.2). We will come back later and compare these
results to the Four Quadrant option.

Figure 4.2 Pump Model tab for Pump J6. The pump behavior with
forwards and backwards flow can be seen in the Flow
Directional Behavior section.



J7 & J9 - Valves
1. Inlet Elevation = 0 feet

2. Cv = 10,000

3. Click the Transient tab

4. Transient Data =

Time
(seconds) Cv

0 10,000

3 1,000

5 0

15 0

J12 & J13 - Spray Discharges
These junctions each represent numerous spray nozzles that are modeled
as a single nozzle for simplicity.
1. J12 Name = CT #1

2. J13 Name = CT #2

3. Elevation = 80 feet

4. Loss Model = Cd Spray (Discharge Coefficient)

5. Geometry = Spray Nozzle

6. Exit Pressure = 0 psig

7. Cd = 0.6

8. Discharge Flow Area = 10 feet2
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C. Check if the pipe and junction data is complete
Turn on “Show Object Status” from the toolbar or View menu to verify
if all data is entered. If so, the Pipes and Junctions group in Analysis
Setup will have a check mark. If not, the pipe or junction number of any
uncompleted pipes or junctions will be shown in red. If this happens, go
back to the uncompleted pipes or junctions and enter the missing data.

Step 4. Specify the Pipe Sectioning and Output group

Open Analysis Setup and go to the Sectioning panel. When this panel is
first opened, it will automatically search for the best (least number of
sections within 10% variance) option for one to five sections in the
controlling pipe. The results will be displayed in the table at the top. No
input is required for this step.

Step 5. Define the Transient Control group

Go to the Simulation Mode/Duration panel in the Transient Control
group and enter a Stop Time of 15 seconds. Next, in the Save Output To
File section, change the selection to Every 10 Time Steps to reduce
runtime.

Step 6. Run the model

All groups in Analysis Setup should now be complete and the model
ready to run. Run the model by pressing the “Run Model” icon on the
Workspace Toolbar, selecting “Run Model” in the Analysis menu, or
pressing CTRL+R on the keyboard. This will open the Solution Progress
window. When complete, press the “Output” button.

Step 7. Review results

Clicking “Output” from the Solution Progress window, selecting the
Output tab, or pressing CTRL+U on the keyboard will take you to the
Output window, which will display any warnings



A warning is given for each pump stating that the pump experienced
reverse flow and was using a Standard Pump Curve, meaning that the
zero-flow head value was used to predict head and power at reverse
flow. If the reverse flow is low in magnitude and duration, using the
zero-flow head may be a good assumption. We will examine the impact
of using a four quadrant curve as suggested by this warning later in this
example.

In addition, a caution is given for each pump that the end of curve flow
was exceeded. In this model we did not explicitly define the end of
curve flow, so the highest flowrate that was entered was assumed to be
the end of curve flow. The pump head and power curve fits will only be
reliable within the range of data entered by the user, thus predictions at
flow rates above this range will be inaccurate, particularly when the
pump is operating at full speed. Operating beyond the end of curve is
less of a concern when the pump is operating at lower speeds, such as
occurs for the pump in this case since the end of curve is only exceeded
after the pump trip beings. However, it is still prudent to verify that the
effect of operating past the end of curve is low by using a four quadrant
curve.

The Graph Results window will be useful in evaluating the results. We
will graph the static pressure and volumetric flowrate at the pump
suction and valve discharge as a dual y-axis graph to see how these
parameters vary with time.

A. Graph the transient pressures and flows at the pump
station
1. Change to the Graph Results window from the Window menu, by

clicking on the Graph Results tab, or by pressing CTRL+G.
2. Go to the Transient Pipe tab on the Graph Control tab and add Pipe

P5 Outlet and Pipe P7 Inlet under “Graph These Pipes/Stations”.
These locations represent the pump suction and valve discharge
piping, respectively.

3. Select the “Time Units” as seconds and ensure that the “Time
Frame” is showing “All Times”.

4. Add a second parameter to be graphed by clicking on the “Add”
button, represented with the green “+” icon. Select “Pressure
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Static” as one parameter to be graphed and “Volumetric Flowrate
Upstream” as the second parameter to be graphed.

5. Move the Volumetric Flowrate Upstream to the secondary Y-axis
by clicking the “Make Secondary Y-axis” button, which is the blue,
right arrow icon. This parameter should now be indented.

6. Set the units to “psig” for the static pressure and “gal/min” as the
volumetric flowrate.

7. Click Generate. The resulting pressure and flow transients are
shown in Figure 4.3.

8. Click the Add Graph to List button from the Toolbar to save this
graph to the Graph List Manager so that it can be regenerated later,
and name it “Pressure & Flowrate vs. Time”.

In Figure 4.3 you can see that the pressure increases at the pump inlet
and decreases at the valve outlet until a maximum pressure of 32.6 psig
at the pump inlet and a minimum pressure of 16.2 psig at the valve
outlet is reached. The pressures then begin to oscillate once the
discharge valve becomes fully closed.



Figure 4.3 Pressure and volumetric flow rate transients using the
standard pump curve data.

B. Graph the pump speed decay
You can graph certain junction properties for junctions in your model.
To generate these graphs, the junction output data will need to be saved
to file. You can specify which junctions you wish to save output data for
by checking the box next to the junctions of interest in the Output
Junctions panel in the Pipe Sectioning and Output group of Analysis
Setup.

To graph the pump speed decay,
1. Return to the Graph Control tab on the Quick Access Panel.

2. On the Transient Junction tab, add Pump J6.

3. In the Parameter definition area, choose “Pump Speed” as the
parameter to be graphed.
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4. Choose “Percent” in the Units column.

5. Click Generate.

The predicted pump speed is shown in Figure 4.4. Click the Add Graph
to List button from the Toolbar to save this graph to the Graph List
Manager so that it can be regenerated later, and name it “Speed vs.
Time”.

Figure 4.4 The pump speed decay is shown. The speed decays
quickly at first, and then slows down after the check
valve closes and the flow goes to zero.

Step 8. Create additional pump scenarios

To check the validity of our results when using the standard pump curve
to perform the pump trip with inertia, we should now go back and run
the model with the pumps specified using four quadrant data for
comparison. We will create three child scenarios, one for the current
pump configuration using the Standard Pump Curve, and two using a
Four Quadrant Data Set.

To do this, click the "Create Child" button on the Scenario Manager on
the Quick Access Panel. Name the child “Standard Pump Curve”. A
new scenario will appear below the Base Scenario in the scenario tree.



Select the Base Scenario, create another child, and call it “Four
Quadrant BEP”. We will later clone this scenario to create our third
child scenario.

The “Standard Pump Curve” Scenario will use the pump settings that
were already defined, so no changes will be needed for this scenario.

A. Four Quadrant BEP
Load the “Four Quadrant BEP” scenario by double-clicking the name in
the Scenario Manager. Open the Pump Properties window for pump J6.
1. Select the option for “Four Quadrant Curve”. (Figure 4.5)

2. Under the “Four Quadrant Curve” option click “Specify Model…”

3. AFT Impulse provides multiple pre-defined Four Quadrant Data
sets which are characterized by specific speed. To choose a data set
to use, we will first estimate the specific speed for the pump, which
AFT Impulse will use to recommend a data set. To do this, click
“Suggest a Data Set” under “Four Quadrant Data Set”.

4. By default, AFT Impulse will select "Calculated from Standard
Pump Curve", which allows most of the data to be automatically
populated from the Pump Properties window. In this case the
predefined data is accurate for the pump, so click Calculate.
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Figure 4.5 The Pump Model tab defined using the Four Quadrant
Curve. The Flow Directional Behavior section shows
the pump behavior for different flow and speed cases.

5. The specific speed is estimated to be 6,810 gpm units, suggested
data set Ns = 7600 gpm units. Click “Suggested Data Set and
Close". The Ns = 7600 gpm units data set will now be selected, and
the dimensionalized curve will be displayed against the previously
entered Standard Pump Curve. (Figure 4.6)

Note: It is always advised to select a "Preferred" data set close to the
pump's specific speed when possible. An "Average" data set may be
selected if there are no close "Preferred" data sets, as was done here.

6. Make sure that the Four Quadrant Curve Dimensional Reference
Point is set to use the Best Efficiency Point. We will select the
Steady-State Operating Point option later for the third scenario.
Click OK on this window and the Pump Properties window.

7. Repeat steps 1 through 6 for junction J8. The required input for this
scenario is now complete.



Figure 4.6 The Specify Four Quadrant Model window can be
used to select and view options for the
dimensionalized four quadrant data set

B. Four Quadrant SSOP
Clone the “Four Quadrant BEP” scenario by right-clicking the scenario
name in the Scenario Manager and choosing “Clone Without Children”.
Name this cloned scenario “Four Quadrant SSOP”. For pump J6 and J8,
open the Pump Properties window and click the Specify Model… button
under Four Quadrant Curve. Change the Four Quadrant Curve
Dimensional Reference Point to Steady-State Operating Point, then click
OK on all open windows to accept the changes. The required input for
this scenario is now complete.

Step 9. Run the four quadrant scenarios

Using the Scenario Manager load each of the four quadrant scenarios
and run them. Once all of the scenarios have been run, go to the Graph
Results tab. Multi-scenario graphing can be used to compare the results
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for all of these scenarios. To create the multi-scenario graph, do the
following.
1. Double-click the “Pressure & Flowrate vs. Time” graph in the

Graph List Manager on the Quick Access Panel. This will load the
saved graph for the current scenario.

2. Select the Multi-Scenario button in the Parameters section of the
Quick Access Panel. Check the box next to each of the child
scenarios so that they will be included in the multi-scenario graph.

3. Click OK to confirm your selections, then click Generate to update
the graph to include the additional scenarios. (Figure 4.7)

As shown in Figure 4.7, the colored curves of the Standard Pump Curve
scenario and the two four quadrant scenarios produce results that are
practically indistinguishable.

Comparison between the four quadrant graphs and standard pump curve
graph reveals that the results are similar, though there is a visible
difference of about 2 psig between the maximum and minimum points
in the four quadrant scenario graphs and the standard pump curve
scenario graph after the discharge valves close fully at five seconds.
These differences can be attributed to the larger flow oscillations that
occur when the pump head is fixed to the zero flow head for all values
of reverse flow. Overall the effects of reverse flow and exceeding the
end of curve flow are minor in the standard pump curve scenario.



Figure 4.7 Valve discharge pressure, pump suction pressure,
and volumetric flow rate for the Standard Pump Curve,
Four Quadrant BEP, and Four Quadrant SSOP
scenarios

Now navigate to the Output window for each of the scenarios, then
select the Pump Summary tab in the top third section. Notice that for the
Four Quadrant SSOP and standard pump curve scenarios, the steady
state flow rate is about 10,349 gal/min, while the steady state flow rate
for the BEP scenario is 10,358 gal/min. This difference in the Four
Quadrant BEP scenario results from the fact that the pump is not
operating exactly at BEP, as is the case for most pumps.

While the difference in steady state and transient results for the two
dimensional points is minor in this case, it may become more
pronounced in other cases, and may lead to a trade-off between the
accuracy of steady-state and transient data, especially if the pump
operates further from BEP. Further details on this topic can be found in
the main Help file for AFT Impulse.
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Step 10. Adjust the valve closure

Now, consider the case where the valves at the discharge of the pumps
cannot be closed in five seconds, but instead will close fully at 12
seconds. In this case the reverse flow at the pump will be significant due
to the delay in the valve closure profile. We will need to use a four
quadrant data set to analyze the effects of the possible reverse flow and
reverse rotation in the pump, since the Standard Pump Curve does not
have sufficient data. We will use the default selection to use the pump
BEP as the dimensional reference point, though using the steady state
operating point as the reference point would produce similar results.

In the Scenario Manager, select the Four Quadrant BEP scenario and
create a child scenario named “12 Sec Valve Closure”. The new child
scenario should now be active. Pumps J6 and J8 will already inherit the
four quadrant model from the Four Quadrant BEP scenario, but we will
need to adjust the valves. For Valves J7 and J9 open the Valve
Properties window, then edit the Transient Data table found on the
Transient tab to reflect the following closure profile. This scenario
should now be complete.

Time (seconds) Cv

0 10,000

5 1,000

12 0

30 0

Step 11. Specify the Transient Control group

Since the valve closure takes a longer time, it will be useful to extend
the run time. Open the Simulation Mode/Duration panel from the toolbar
or Analysis menu and change the stop time to 30 seconds, then click
OK.



Step 12. Run the model

The model should now be fully defined and ready to run. Select “Run
Model” in the Analysis menu. View the results by pressing “Graph
Results” at the bottom of the Solution Progress window.

Step 13. Graph results

Load the “Pressure & Flowrate vs. Time” graph from the Graph List
Manager, as seen in Figure 4.8. Note that as expected, a significant
amount of reverse flow occurs at the pump from about 6 to 12 seconds,
requiring data beyond the standard data which is typically used for
forward flow with forward rotation at the pump. The transient results
show that the maximum pressures at the valve outlet and the pump
suction have been reduced.

Figure 4.8 Transient pump suction and discharge pressures and
volumetric flowrates with a 12 second valve closure

The pump speed decay is shown in Figure 4.9. Note how the pump
speed decreases at a faster rate than Figure 4.4. Additionally, at about 10
seconds the pump begins to experience reverse rotation. This means that
from 6 to 10 seconds, the pump will have forward rotation with reverse
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flow, then from 10 to 12 seconds, the pump will experience reverse flow
with reverse rotation. Both of these situations can be accounted for using
the additional information provided by the Four Quadrant Curve.

Figure 4.9 Pump Speed decay when the valves are modified to
close fully at 12 seconds

Conclusion

For the valve closure of five seconds a minimal amount of reverse flow
was experienced at the pump. As a result, the standard pump curve was
sufficient, since use of four quadrant data to accurately model this
reverse flow had only a small impact on the results. Additionally, the
choices of using the BEP or Steady State Operating Point to
dimensionalize the four quadrant data were shown to be very similar in
the transient and the steady state operating point, since the pump was
operating close to its BEP. This is not always the case, especially when
the pump operates far from BEP. For an example which shows larger
sensitivity to the selection of four quadrant data set and choice of
dimensional reference point see the “Selecting a Pump Four Quadrant
Curve” example accessed from “Show Examples…” in the Help menu.

Changing the valve to close fully at 12 seconds resulted in significant
reverse flow at the pump which required four quadrant data to be used.



It was then found that increasing the valve closure time reduced
pressures at the valve and pump.
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Valve Closure With Force Sets Example

This example examines a gravity drain system which transfers water
from one tank to another through a filter and a valve in the connecting
pipeline. It is necessary to determine the transient forces that occur when
the valve is partially closed in order to analyze pipe stresses and loads
on the pipe supports.

Topics covered
l Defining force sets

l Graphing transient forces

l Evaluating the effect of frictional losses on transient pipe forces

l Using Isometric Pipe Drawing Mode

Required knowledge

These examples assume that the user has some familiarity with AFT
Impulse such as placing junctions, connecting pipes, and entering pipe
and junction properties. Refer to Valve Closure Example in Chapter 2
for more information on these topics.



Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT Impulse installation:
l US - Valve Closure with Pipe Forces - Initial.imp

The model file US - Valve Closure with Pipe Forces.imp contains the
completed model, for reference if needed.

Step 1. Start AFT Impulse

From the Start Menu choose AFT Products and AFT Impulse.

Step 2. Open model file

For this example, we will be starting from a pre-built model file which
has the fluid, pipes, and junction properties completed to save time.
From either the startup screen or the File menu, browse to the model file
name shown above. The workspace should appear as shown in Figure
5.1.

A. Isometric Drawing Mode
The previous examples’ models were drawn using the default Pipe
Drawing Mode, 2D Freeform. However, AFT Impulse has two
additional available drawing modes, 2D Orthogonal and Isometric. Due
to the nature of this model the Isometric mode was used to visually
interpret the pipe layout and provide a better understanding of the
system when analyzing calculated forces.

For future reference when using this feature, the Isometric drawing
mode can be turned on in the Arrange menu under Pipe Drawing Mode. 
The isometric grid can also be turned on or off from the Arrange menu.
When drawing segmented pipes such as P5, a red-dashed preview line
will show how the pipe will be drawn on the isometric grid. As you are
drawing a pipe, you can change the preview line by clicking any arrow
key on your keyboard or scrolling the scroll wheel on your mouse. You
can hold the “Alt” key while adjusting a pipe by the endpoint to add an

100 AFT Impulse™ 9 Quick Start Guide



Chapter 5 Valve Closure With Force Sets 101

additional segment. This can be used with the arrow key or mouse scroll
wheel to change between different preview line options.

For junctions such as J5, it may be useful to rotate the icon to be aligned
with the isometric grid. This can be accomplished by right-clicking on
the junction and choosing “Customize Icon”.

Figure 5.1 Layout of gravity drain system with isometric grid on

Note: Pipe forces are typically calculated around pairs of pipe direction
changes or at single points where the pipe is interrupted (for example, at
an untied or non-pressure compensated expansion joint). These locations
must be determined from piping drawings showing the physical
arrangement of the piping, then related to the corresponding pipe in the
AFT Impulse model along with the length along the pipe where the
direction change or pipe interruption is located. Intermediate elevations
are not necessary but are included here for later discussion.



Step 3. Specify the Pipe Sectioning and Output group

Open Analysis Setup and go to the Sectioning panel. When this panel is
first opened, it will automatically search for the best (least number of
sections within 10% variance) option for one to five sections in the
controlling pipe. The results will be displayed in the table at the top. No
input is required for this step.

Note: The closer the computing stations are to the desired force
calculation location, the more accurate the force calculation will be.

Step 4. Specify the Transient Control group

Go to the Simulation Mode/Duration panel in the Transient Control
group and enter a Stop Time of 10 seconds.

Step 5. Define the Forces group

Go to the Forces Definitions panel in the Forces group. Define a force
set by clicking New, then entering the data as shown in Figure 5.2.
Repeat this process for the second force set.

Figure 5.2 The completed Force Definitions panel
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Since the force sets in this example calculate the force imbalance
between adjacent pipe direction changes, the default force type of
‘Difference’ is used. The ‘Point’ type would be used for calculating the
force at a location where the fluid is leaving the system, such as an exit
valve. The additional difference methods are available to analyze forces
across more than two pipes, or for cases where a user defined exit area
would be useful, such as for forces across a nozzle.

For a specified length to start node and length to end node, AFT Impulse
will determine and display the nearest computing station number and
actual length from inlet of the start and end pipe to the node within the
pipe.

Sectioning has produced one section each in pipes P2 and P3 for the 480
ft to 520 ft force set and then 24 sections and 4 sections in pipes P4 and
P5, respectively for the 520 ft to 1040 ft force set. Section length is 20
feet for each pipe.

In our example, this sectioning conveniently results in computing
stations at the locations where we want to calculate forces. Where
computing stations do not coincide with the desired force calculation
locations, some loss in accuracy will occur. By increasing the number of
sections in the controlling pipe during sectioning, a greater number of
computing stations will exist, thus reducing the distance to the desired
force calculation locations, at the expense of longer run time.

Note: AFT Impulse will set Pipe Station Output automatically to include
only those stations required by the force set nodes up to five stations, or
all stations if more than five stations are required.

Click OK to close Analysis Setup.

Step 6. Run the model

All groups in Analysis Setup should now be complete and the model
ready to run. Run the model by pressing the “Run Model” icon on the
Workspace Toolbar, selecting “Run Model” in the Analysis menu, or
pressing CTRL+R on the keyboard. This will open the Solution Progress
window. When complete, press the “Output” button.



Step 7. Graph the pipe forces

Go to the Graph Results window and select the Forces tab from the
Graph Parameters section on the Quick Access Panel. The force sets
defined on the Force Definitions panel will appear as available forces to
graph.

Check the box next to the "480 ft to 520 ft" force set. This corresponds
to the elevation change between the branch junctions of 40 feet and 0
feet specified from pipes P2 and P3. Also check the box next to the “520
ft to 1040 ft” force set, which corresponds to the force over the closing
valve. Click Generate, and the following force vs time graph is
displayed (Figure 5.3).

Figure 5.3 Force vs. Time for both force sets

Note that at time zero, which represents the initial, steady state results,
there is no force imbalance. This is the expected results for a system at
steady state.

Some traditional methods of analyzing force sets will not have this same
result, since they do not include the effects of friction or momentum in
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their force balances. If the graph from Figure 5.3 created with friction
and momentum ignored, the steady state values calculated as
approximately -1,270 lbf and -2,700 lbf. Due to this effect, AFT Impulse
will always include both friction and momentum when graphing force
sets.

In summary, there are two important points to be observed here:
1. AFT Impulse calculates transient, or time varying hydraulic forces.

This does not include constant loads from fluid, piping and
component weight. A comprehensive analysis of pipe loading must
separately include these items.

2. In some cases, ignoring friction and momentum force balance
components will result in force imbalances that do not exist in
reality, since the frictional forces on the pipe exactly
counterbalance the force calculated from the pressure differential at
the selected locations.

A. Final notes
An AFT Impulse model does not contain directional data with regard to
the forces, it knows only pipe length and elevation. Since forces are
vectors with both magnitude and direction, the user must identify the
direction of the calculated forces using data in the pipe arrangement
drawing that defines the geometry of the pipe routing.

Analysis summary

In this example it can be seen that AFT Impulse is capable of predicting
transient hydraulic forces which occur in the system due to surge.
Including frictional results is important to avoid force imbalance in the
steady state. With the data that is obtained from the force sets in AFT
Impulse the engineer can then export this information to CAESAR II,
ROHR2, TRIFLEX or other pipe stress analysis software for further
analysis on the impact of forces on the structural support.



106 AFT Impulse™ 9 Quick Start Guide



C H A P T E R 6

AFT Impulse Add-on Modules Examples

This chapter covers the Settling Slurry (SSL) and Pulsation Frequency
Analysis (PFA) modules. The user can only perform these examples if
access to the relevant modules is available.

Topics covered
l Defining settling slurry properties

l Reviewing slurry output

l “Ringing” systems to find natural acoustic frequencies

l Finding system excitation frequencies

l Calculating pressure response of system at ‘worst case’ positive
displacement pump speeds

Required knowledge

These examples assume that the user has some familiarity with AFT
Impulse such as placing junctions, connecting pipes, and entering pipe
and junction properties. Refer to Valve Closure Example in Chapter 2
for more information on these topics.



Model files

This example uses the following files, which are installed in the
Examples folder as part of the AFT Impulse installation:
l US - Pipe Sizing for Sand Transfer - SSL.imp

l US - PD Pulsation Study - PFA.imp

SSL problem statement

Sand is being transferred from a quarry sand pit to receiving deposits in
two different locations. There are two valves that control the flow to
each of these deposits by changing their opening position (modeled as
Cv). The ratio of the mixture velocity to the velocity at which the sand
will settle out of the liquid and form a stationary bed on the bottom of
the pipe (Vm/Vsm) must be kept above 1.2 to avoid potentially plugging
the pipe. Determine if the pipe size and velocity ratio is acceptable
during the transient where one valve starts to close while the other opens
further.

SSL Step 1. Start AFT Impulse

From the Start menu, choose AFT Products and AFT Impulse. On the
Startup window, select to activate the SSL module. If AFT Impulse is
already running, activate the SSL module from the Modules panel in
Analysis Setup.

SSL Step 2. Define the Fluid Properties group

With the SSL module enabled, the four items in the Fluid Properties
group in Analysis setup change to the three items required for defining a
slurry: the Carrier Fluid panel, Solids Definition panel, and the Slurry
Definition panel. Open Analysis Setup to define these items.
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A. Carrier Fluid panel
1. Go to the Carrier Fluid panel (Figure 6.1)

2. Carrier Fluid = Basic (Water)

3. Temperature = 70 deg. F

Figure 6.1 Completed Carrier Fluid panel

B. Solids Definition panel
1. Go to the Solids Definition panel (Figure 6.2)

2. Slurry Calculation Method = Detailed

3. Solids Specifications = User Specified Solids Added

4. Terminal Velocity Parameter = Vt/Vts

5. Value = 0.55

6. Density = 2.65 S.G. water

7. d50 = 0.0275 inches



8. d85 = 0.04 inches

9. Bulk Modulus = 2,320,000 psia

Figure 6.2 Completed Solids Definition panel

C. Slurry Definition panel
1. Go to the Slurry Definition panel (Figure 6.3)

2. Concentration Type = Volume Fraction

3. Amount Solids Added = 20 Percent

4. Click OK to save and close Analysis Setup
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Figure 6.3 Completed Slurry Definition panel

SSL Step 3. Define the Pipes and Junctions group

A. Place the pipes and junctions
In the Workspace window, assemble the model as shown in Figure 6.4.



Figure 6.4 Layout of pipe system for Sand Transfer to Two
Locations example

B. Enter the pipe and junction data
The system is in place, but now the input data for the pipes and
junctions need to be entered. Double-click each pipe and junction and
enter the following data in each Pipe and Junction Properties window.

Pipes
All pipes are Steel - ANSI, 10 inch Size, STD Type, Standard Friction
Model, Thick-Walled Anchored Upstream Pipe Support, with the
following lengths:
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Pipe Length (feet)

1 10

2 400

3 5

4 85

5 400

6 5

7 100

8 700

J1 - Reservoir
1. Name = Sand Pit

2. Liquid Surface Elevation = 0 feet

3. Liquid Surface Pressure = 0 psig

4. Pipe Depth = 0 feet

J3 - Branch
Elevation = 4 feet

J5 - Branch
Elevation = 20 feet

J8 - Branch
Elevation = 30 feet

J6 - Reservoir
1. Name = Deposit #1

2. Liquid Surface Elevation = 20 feet



3. Liquid Surface Pressure = 0 psig

4. Pipe Depth = 0 feet

J9 - Reservoir
1. Name = Deposit #2

2. Liquid Surface Elevation = 30 feet

3. Liquid Surface Pressure = 0 psig

4. Pipe Depth = 0 feet

J2 - Pump
1. Name = Main Slurry Pump

2. Inlet Elevation = 4 feet

3. Pump Model = Centrifugal (Rotodynamic)

4. Enter Curve Data =

Volumetric Head Power

gal/min feet hp

0 500 1025

4000 475 1100

7000 400 1200

9000 300 1350

5. Curve Fit Order = 2

J4 - Valve
1. Name = Valve to Deposit #1

2. Inlet Elevation = 4 feet

3. Cv = 500
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4. Click the Transient tab

5. Transient Data =

Time
(seconds) Cv

0 500

1 500

6 300

10 300

J7 - Valve
1. Name = Valve to Deposit #2

2. Elevation = 4 feet

3. Cv = 400

4. Click the Transient tab

5. Transient Data =

Time
(seconds) Cv

0 400

5 500

10 500

C. Check if the pipe and junction data is complete
Turn on “Show Object Status” from the toolbar or View menu to verify
if all data is entered. If so, the Pipes and Junctions group in Analysis
Setup will have a check mark. If not, the pipe or junction number of any
uncompleted pipes or junctions will be shown in red. If this happens, go
back to the uncompleted pipes or junctions and enter the missing data.



SSL Step 4. Specify the Pipe Sectioning and Output group

Open Analysis Setup and go to the Sectioning panel. When this panel is
first opened, it will automatically search for the best (least number of
sections within 10% variance) option for one to five sections in the
controlling pipe. The results will be displayed in the table at the top. No
input is required for this step.

SSL Step 5. Specify the Transient Control group

Go to the Simulation Mode/Duration panel in the Transient Control
group and enter a Stop Time of 10 seconds.

SSL Step 6. Run the model

All groups in Analysis Setup should now be complete and the model
ready to run. Run the model by pressing the “Run Model” icon on the
Workspace Toolbar, selecting “Run Model” in the Analysis menu, or
pressing CTRL+R on the keyboard. This will open the Solution Progress
window. When complete, press the “Output” button.

SSL Step 7. Review results

Click “Output” on the Solution Progress window will take you to the
Output window.

A. Check the Transient Max/Min
As a design objective, the system is required to have at minimum a
Vm/Vsm of 1.2 to avoid the potential of the sand falling out of the
slurry and plugging the pipe.

By inspecting the Min. Vm/Vsm column in the Transient Max/Min tab,
as shown in Figure 6.5, it can be seen that the minimum Vm/Vsm drops
below this value in pipe P4.

116 AFT Impulse™ 9 Quick Start Guide



Chapter 6 AFT Impulse Add on Modules 117

Note: A Design Alert could be defined in the Tools menu to
automatically evaluate if this design objective is met, and issue a
warning if the condition is not satisfied. A predefined Design Alert for
this model can be seen by opening the US - Pipe Sizing for Sand
Transfer - SSL.imp model file which is installed in the Examples folder
in the AFT Impulse 9 folder.

Figure 6.5 Design objective violation in pipe P4 station 17

There are several factors that may be contributing to this low Vm/Vsm
value. Pipe P4 is sloped upward which increases the settling velocity
and decreases the velocity ratio of concern. Also, all pipes in the model
have a 10 inch diameter. However, the main Pipes P1 and P2 are
carrying much more flow than the others so the pressure drop in these is
greater. This can be reduced by increasing the size. The size cannot be
increased too much because this would reduce the velocity ratio below
the 1.2 minimum.

Return to the Workspace and change Pipes P1 and P2 to have a 14 inch
diameter. Since the size of the pipes was changed, the pipes need to be
re-sectioned by opening the Sectioning panel in the Analysis Setup
window. Click OK to accept the results.

Re-run the model and view the Output. All pipes should meet the
requirements now that the pipes were changed. The Graph Results
window will be more useful in understanding the results.



B. Graph the velocity ratio and pressures to Deposit #1
You will use stacked graphs to simultaneously view the maximum and
minimum velocity ratio and pressures in the system during the transient.
1. Change to the Graph Results window from the Window menu, by

clicking on the Graph Results tab, or by pressing CTRL+G.
2. Open the Profile tab on the Graph Control tab.

3. Select pipes P1, P2, P3, P4 and P5 (Figure 6.6). These represent the
flow path to Deposit #1.

4. In the Parameters definition area, ensure that there are two
parameters by selecting the green “+” icon to add a parameter to
graph. Choose “Velocity Ratio (Vm/Vsm)” for one parameter and
“Pressure Static” for the other.

Figure 6.6 Data selection to view the maximum and minimum
values of the velocity ratio and static pressure along
the flow path to Deposit #1
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5. Specify “psig” as the Units for the Pressure Static parameter.

6. Make sure both of the boxes under the “Mx” and “Mn” columns
for both parameters are checked to ensure that the maximum and
minimum values are being displayed for both graphs. If a design
alert has been created, this can be added to the plot as well by
checking the box under “DA”.

7. Click Generate. The resulting graphs are shown in Figure 6.7.

Recall that, before modifying pipes P1 and P2 to 14 inch pipe, the
minimum velocity ratio was below the design alert limit of 1.2 for a
portion of the path. Now with 14 inch pipe, the minimum is above the
1.2 limit along the entire path. You can also check the same parameters
for the flow path leading to Deposit #2.

Figure 6.7 Maximum and minimum velocity ratio and static
pressure values in the flow path to Deposit #1. Note
that the velocity ratio is above the minimum Design
Alert of 1.2 at all locations.



C. Graph the velocity ratio over time
A time comparison of the velocity ratio in the critical pipes along the
two flow paths is important to consider. To create this graph:
1. Return to the Graph Control tab on the Quick Access Panel.

2. On the Transient Pipe tab, select Pipes P4 Inlet and P14 Inlet and
add them to the pipe stations to graph (Figure 6.8). These are the
two sloped pipes which have the lowest velocity ratio.

3. In the Parameters area, choose Velocity Ratio (Vm/Vsm).

4. Click Generate.

The resulting graph is shown in Figure 6.9. This shows that, as Valve J4
closes and Valve J14 opens, the velocity ratios in the pipe immediately
downstream change but stay in the acceptable range.

Figure 6.8 Data selection to view the velocity ratio over time
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Figure 6.9 The velocity ratio in the sloped pipes as the valves
change position

SSL analysis summary

A slurry of sand and water flowing to two deposits was modeled. The
velocity ratio was examined to ensure a minimum value was maintained
throughout the transient to avoid the danger of the sand settling out of
the slurry and plugging the pipe. The analysis showed that the initial
pipe diameter selected was not adequate. A larger size was selected to
meet the system requirements over the simulation time.

PFA problem statement

A system with positive displacement pumps has a known pulsation issue
in a section of piping with a closed valve. This issue is caused by the
system’s natural frequency resonating with certain PD pump
frequencies, resulting in severe pressure oscillations at the closed valve.
A forcing function will be placed on the PD Pump to discover the



natural acoustic frequencies, which will then be used to find the worst-
case scenarios for the system.

PFA Step 1. Start AFT Impulse

From the Start Menu choose AFT Products and AFT Impulse. From the
Startup window under the "Activate Modules" section in the middle
panel, select the PFA (Pulsation Frequency Analysis) option to activate
the PFA module. If AFT Impulse is already running, activate the PFA
module from the Modules panel in Analysis Setup.

PFA Step 2. Define the Fluid Properties group
1. Open Analysis Setup using the button on the toolbar or from the

Analysis menu.
2. Open the Fluid panel and make sure User Specific Fluid is selected

3. Name = PFA Fluid

4. Density = 57.3 lbm/ft3

5. Dynamic Viscosity = 2.3 lbm/hr-ft

6. Bulk Modulus = 140,000 psia

PFA Step 3. Define the Pipes and Junctions group

At this point, the first two groups are completed in Analysis Setup. The
next group is the Pipes and Junctions group.

A. Place the pipes and junctions
In the Workspace window, assemble the model as shown in Figure 6.10.
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Figure 6.10 Layout of PD Plunger Pulsation Study example

B. Enter the pipe and junction data
The system is in place, but now the input data for the pipes and
junctions need to be entered. Double-click each pipe and junction and
enter the following data in each Pipe and Junction Properties window.

Pipes
All pipes use user-specified material with the following inputs.
Throughout the model a User Specified Wavespeed of 3000 feet/sec is
used, and the absolute roughness is 0.0006 inches.



Pipe
Inner

Diameter
(inches)

Length (feet)

1 12 3

2 12 3

3 2.157 39

4 2.157 57

5 3.26 33

6 1.682 21

7 3.26 48

8 1.682 3

9 3.26 30

J1 & J2 - Assigned Flows
For the sake of simplicity, assigned flow junctions are being used to
represent the PD pumps with the information listed below. The Pulsation
Setup group in Analysis Setup will be used later to place the necessary
transient data in the assigned flow junction for the pump being analyzed.
1. Elevation = 0 feet

2. Flow Specification = Volumetric Flow Rate

3. Flow Rate = 35.5 gal/min

J3 & J4 - Area Changes
1. Inlet Elevation = 0 feet

2. Type = Abrupt Transition (Cylindrical)

J8 & J9 - Area Changes
1. Inlet Elevation = 0 feet

2. Type = Conical Transition
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3. Angle (μ) = 90 Degrees

J5 & J6 - Tees
1. Elevation = 0 feet

2. Loss Model = Simple

J10 - Spray Nozzle
1. Elevation = 0 feet

2. Loss Model = Cd Spray (Discharge Coefficient)

3. Geometry = Spray Nozzle

4. Exit Properties = Pressure

5. Exit Pressure = 0 psig

6. Cd (Discharge Coefficient) = 1

7. Discharge Flow Area = 0.02313 inches2

J7 - Dead End
Elevation = 0 feet

C. Check if the pipe and junction data is complete
Turn on “Show Object Status” from the toolbar or View menu to verify
if all data is entered. If so, the Pipes and Junctions group in Analysis
Setup will have a check mark. If not, the pipe or junction number of any
uncompleted pipes or junctions will be shown in red. If this happens, go
back to the uncompleted pipes or junctions and enter the missing data.

PFA Step 4. Define Pulsation Setup group

Defining the initial pulse or “ring” is an important step in determining
the natural frequencies that different stations in the model will respond
to. This is the numerical equivalent of hitting the system with a hammer
to see how it responds at different frequencies. This first step does not
represent a realistic operating condition, but rather reveals what
frequencies of real-world operation may present operational problems.



Open Analysis Setup and go to the Pulse Setup panel in the Pulsation
Setup group. The Pulsation Setup group is the main interface for
specifying input regarding the initial pulse and other information about
the pulsation source. There are two items in the Pulsation Setup group:
the Pulse Setup panel and the PD Pump Settings panel. The PD Pump
Settings panel only requires input if the source of pulsation is a positive
displacement pump. Since the source of pulsation in our model is a
positive displacement pump, we will need to complete the input on both
of these panels.

A. Define the Pulse Setup panel
Define the Pulse Setup panel (Figure 6.11) using the following values:
1. Applied At = J2 (Assigned Flow)

2. Start Time = 0 seconds

3. Magnitude = Automatic (Twice Steady-State Flow)

4. Peak = 71.00 gal/min

5. Cutoff Frequency = PD Pump Characteristics

6. Value = 86.25 Hz

7. Filter Typer = Chebyshev

8. Order = 10

9. Ripple Allowed = 1 dB

10. Pulsation Source = Positive Displacement (PD) Pump

11. Number of Heads = 3

12. Pump Speed = 250 RPM

13. Speed Buffer = 15 Percent (%)
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Figure 6.11 Completed Pulse Setup panel

B. Define the PD Pump Settings panel
Define the PD Pump Settings panel (Figure 6.12) using the following
values:
1. Minimum Pump Speed = 125 RPM

2. Bore = 3 inches

3. Stroke = 2.04 inches

4. Rod Length = 10 inches

5. Clearance = 70 Percent (%)

6. Suction Pressure = 50 psig

7. Discharge Pressure = 6000 psig



Figure 6.12 Completed PD Pump Settings panel

PFA Step 5. Section the pipes

Go to the Sectioning panel in the Pipe Sectioning and Output group of
Analysis Setup. While using the AFT Impulse PFA module, the
pulsation setup needs to be completed prior to sectioning the pipes in the
model. To section the model’s pipes for the simulation, complete the
following:
1. Select the significant pipes that should consider variance. In our

example, we will consider the variance in all modeled pipes, except
for pipe P8. You can see that this pipe has been excluded in Figure
6.13. Pipe P8 is excluded because it represents a flow meter and
not an actual pipe. Units such as flow meters and dampeners may
be better modelled with a pipe than with a junction if they have
significant length and associated acoustic interaction aspects in the
physical system. Ensure that the box next to each pipe is selected
under Consider Variance, except for pipe P8.
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Figure 6.13 Sectioning panel excluding the variance at P8

2. Select 1 section in the controlling pipe by clicking on 1 section in
the table under Search Results.

3. Select Show Pulsation Graphs located at the bottom left of the
Sectioning panel. A graph of the pulse will appear (see Figure
6.14). You can also view graphs for the FFT of the Pulse, the LPF
of the Pulse FFT, and the FFT of the LPF in the Graph Parameter
graph that appears. After you are done viewing these graphs, click
Close.

4. Click OK to close the Analysis Setup window, and click OK for
the pop-up window notifying you that the forcing function has been
placed on J2 (the junction that was selected in the Pulse Setup
panel) as transient data.

5. Open J2 to verify that the numerical “ring” has been applied to the
transient (see Figure 6.15 for the transient input). This transient is a
brief jump in flow rate at junction J2.

PFA Step 6. Run the model

All groups in Analysis Setup should now be complete and the model
ready to run. Run the model by pressing the “Run Model” icon on the
Workspace Toolbar, selecting “Run Model” in the Analysis menu, or
pressing CTRL+R on the keyboard. This will open the Solution Progress
window. When complete, press the “Output” button.



Figure 6.14 Graphs of Pulse and LPF of Pulse in this example
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Figure 6.15 Assigned Flow Properties with forcing function
applied to J2. Choosing “Show Graph…” under the
data shows this in graphical form.



PFA Step 7. Review results

A. Find excitation frequencies to study
1. On the Graph Control tab on the Quick Access Panel, click the

Frequency tab to begin generating an Excitation Frequency
Analysis graph.

2. We need to determine which frequencies excite the pump speeds
within the pump speed range we have specified. For the purposes
of this example, we will graph the Excitation Frequency graph for
10 different pipe stations. Note that it is the engineer's
responsibility to evaluate all pipe stations that could be excited by
various frequencies and to perform the necessary analysis.

3. On the Graph Results tab, select the Frequency tab and select the
inlet and outlet stations for the following pipes: 1, 2, 3, 5, and 6.

4. Click Generate. The resulting graph (shown in Figure 6.16)
represents the frequencies that are excited by the pulse defined in
the Pulsation Setup group.

From the graph in Figure 6.16, we see that there are several frequencies
that produce a large pressure magnitude.  Points on the plot with a large
response magnitude are easily identified by finding local maxima on the
graph. These maxima are the acoustic natural frequencies that are
potentially the most damaging when excited by the identified pump
speeds.

Note that the graph in Figure 6.16 can quickly be changed to display the
magnitude on a logarithmic scale in order to allow for easier viewing of
the magnitude behavior changes with a changing frequency. To view the
Excitation Frequency Analysis graph with the magnitude displayed on a
logarithmic scale, generate the frequency graph as discussed above.
Right-click on either axis and select the box next to Logarithmic.
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Figure 6.16 Excitation Frequency Analysis graph

B. Evaluate excitation frequencies
The identified frequencies can now be evaluated to determine pump
speeds that would cause them to be excited. These natural frequencies
need to be evaluated to examine potentially problematic pump speeds.
Follow the steps below to select the excitation frequencies:
1. With the crosshair cursor off, left-click near the frequency of

around 32.6 Hz and drag the mouse over the peak on the graph
near this frequency. This will highlight and flag the local
maximum.

2. Right-click on the dialog flag that appears on the peak of this
frequency, as demonstrated in Figure 6.17.

3. Select "Evaluate Excitation Frequency" to add this frequency to the
Pump RPM Evaluation panel, which is labeled with "Excitation
Frequencies and Pump Speeds (RPM)". Repeat steps 1 through 3
for the local maxima around the frequencies of 28.8 Hz and 7.1 Hz.
The panel should now appear as shown in Figure 6.18.



Figure 6.17 Excitation Frequency Analysis with Dialog Flag. Right-
clicking on the Dialog Flag provides the option to
Evaluate Excitation Frequency.

Figure 6.18 Pump RPM Evaluation Panel with Excitation
Frequencies and their Harmonic Multiples Displayed
in the bottom of the Quick Access Panel
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When choosing low or high frequencies on the graph, it is possible to
select a frequency which is excited in the system but does not have a
pump speed within the minimum and maximum pump speeds for the
analysis. The minimum pump speed is defined directly in the PD Pump
Settings panel, while the maximum is calculated using the Pump Speed
and Speed Buffer defined under “Pulsation Source” in Pulse Setup
panel. For example, try selecting the largest maxima, which occurs at
6.1 Hz. The message in Figure 6.19 appears.

Figure 6.19 Message Indicating No Excitation Pump Speeds
Between the Min and Max Pump Speeds Exist

Determine the pressure response of the system at excited
frequencies
In the Pump RPM Evaluation panel, corresponding pump speeds can be
selected for study. At these speeds, the pressure response is important to
characterize. By default, all speeds in the Pump RPM Evaluation panel
are pre-selected and must be clicked to be turned off. Child Pump Speed
scenarios can then be created that will have the Flow vs. Time profile at
the selected speed (RPM) that will excite the evaluated frequencies.

We will create child scenarios for all in the Pump RPM Evaluation
panel. To do this, ensure that pump speeds are selected (not italicized).
1. Click “Create Scenarios Based On Selected Pump Speeds…”

2. A dialog box will appear stating that six scenarios will be created
based on the selected speeds in the Pump RPM Evaluation panel.
Click Yes to continue creating the child scenarios (this may take a
few minutes).

3. Double-click on the "130.4 RPM (32.6 Hz)" child scenario to load
it as the current scenario.



The scenario will now have different transient information in J2,
modeling the pump performance at130.4 RPM. Go to the Workspace
and open the Properties window for J2. On the Transient tab click Show
Graph under the Transient Data table to verify the Pump Flow Forcing
Function has been applied, as shown in Figure 6.20.

Figure 6.20 New Assigned Flow transient representing the PD
Pump operating at RPM

Run the "130.4 RPM (32.6 Hz)" scenario to see the pressure response.
Often, the most noticeable pressure response will occur in stagnant
branched lines.  For the purposes of this example, we will evaluate the
pressure responses through pipe P6. However, engineers must ensure
that all pipes that could experience significant pressure responses are
analyzed.
1. To create a pressure profile graph in pipe P6, go to the Graph

Results tab and in the Graph List Manager, select Profile for the
graph type
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2. Check the box for Pipe P6

3. Use Pressure Static for the Parameter

4. Use psia for the units

5. Click Generate

6. Right-click on the y-axis to adjust the y-axis scale by unchecking
the Auto Scale box, then changing the Minimum to 3800 and the
Major Val to 200.

Figure 6.21 shows the profile plot for Pipe P6 at a pump speed of 130.4
RPM.

Figure 6.21 Max/Min Pressure Profile of Pipe P6 for 130.4 RPM

The pressure vs. time can be displayed for any pipe station. Plot the
pressure vs. time for pipe P6 by following the directions below:
1. In the Quick Access Panel, select Transient Pipe for the graph type

2. Add the outlet and inlet of Pipe P6 to the “Graph These
Pipes/Stations:” list



3. Use Pressure Static for the Parameter

4. Use psia for the units

5. Set the Time Frame to User Specified with a Start Time of 0 and a
Stop Time of 2 seconds

6. Click Generate (see Figure 6.22)

Figure 6.22 Pressure Oscillations at Inlet and Outlet of Pipe P6 for
130.4 RPM

After looking at these graphs, return to the Output tab and make note of
the message in red at the bottom right of the screen that states that
Warnings Exist. These warnings are reported in the upper third of the
output window and warn the user of potential issues with the model.

The PFA module will check the Peak-to-Peak pressures and compare
them to the permissible values in the API-674 standard. If the limits
from the standard are violated in the model, a warning will appear like
in this case, where the Peak-to-Peak pressures exceeded the allowable
limits. Additionally, the vapor pressure margin is checked. This is the
margin between the minimum pressure and 10% over the vapor
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pressure, per the API-674 standard. More information on this can be
seen on the Applied Standards and Pulsation Summary tabs.

For the purposes of this example, we will repeat these steps for the
pump speed of 217.3 RPM because this pump speed causes the largest
pressure oscillations. When performing an analysis on your system, all
pump speeds that excite the system should be evaluated.

Figure 6.23 shows the Max/Min Pressure Profile for P6 for the pump
speed of 217.3 RPM.

Figure 6.23 Max/Min Pressure Profile of Pipe P6 for 217.3 RPM

Notice the large difference between the maximum and minimum
pressures at the end of the pipe, located next to the Dead End junction.

The large pressure oscillation in Pipe P6 can be seen in Figure 6.24. It is
important to note that the inlet of Pipe P6 does not exhibit as large of a
response as the outlet does. This oscillation, if allowed to continue, can
lead to mechanical and support fatigue and thus failure. It should be
noted in the Output that this scenario also violates the API-674 standard.



Figure 6.24 Pressure Oscillations at Inlet and Outlet of Pipe P6 for
217.3 RPM

PFA analysis summary

AFT Impulse and the PFA (Pulsation Frequency Analysis) module were
used to discover the problematic pump frequencies occurring in a
system with a known pulsation issue. The software was used to identify
these frequencies, and after the frequencies were identified, a
corresponding pump operating speed was examined to find the pressure
response of the system. Using graphing features, the pressure response
was plotted and studied.
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Other AFT Impulse Capabilities

This Quick Start Guide necessarily omitted coverage of a number of
AFT Impulse capabilities. This chapter briefly describes some of the
important capabilities not covered.

Microsoft Excel™ data integration

AFT Impulse includes enhanced Excel importing and robust Excel
exporting. An Excel spreadsheet can be used to vary selected input
parameters in multiple scenarios. Selected output can also be exported to
specified Excel sheets and cells.

Integration with other software and data standards

AFT Impulse includes a number of importing and exporting capabilities.
Piping layouts and dimensional data can be imported from GIS
Shapefiles (SHP) to build a model. CAESAR II Neutral Files (CII) can
be imported into AFT Impulse and EPANET Files (INP) can be both
imported and exported. Additionally, force files can be exported for use
in CAESAR II, TRIFLEX, ROHR2

Piping Component Files (PCF) from AutoCAD Plant 3D, SmartPlant,
PDS, CADWorx, and other software can be imported into AFT Impulse.
These options are all accessed from the File Menu.



Variable density and viscosity modeling

Systems that have variable density and viscosity can be modeled. The
density and viscosity can be assigned on a pipe by pipe base.

Transient cavitation and liquid column separation

AFT Impulse offers the Discrete Gas Cavity model (DGCM) and the
Discrete Vapor Cavity model (DVCM) for modeling transient cavitation
(also known as liquid column separation). These models calculate vapor
volume size over time and account for pressure spikes when cavities
collapse. Vapor volume can be plotted in the Graph Results window.

Positive displacement pumps

AFT Impulse can model positive displacement pumps. Typically, this is
done by modeling the pump as a known flowrate over time.
Complicated periodic flowrates from multiple pistons and/or multiple
out of phase pumps can also be modeled.

Pumps with viscosity corrections

When the liquid is sufficiently viscous, centrifugal pump performance
will be degraded. AFT Impulse models corrections to manufacturer
performance curves during steady and transient flow.

Pumps with variable speed controllers

Pumps with speed controllers can be modeled during steady and
transient flow. Transients caused by flow or pressure control level
changes with time can be modeled.

Pumps as turbines (PAT)

Pumps being operated as turbines can be modeled during steady and
transient flow using the Pump as Turbine model in the Pump junction.
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Flow and pressure control valve transients

AFT Impulse can model flow and pressure control valves. AFT Impulse
accounts for control valves which lose and regain control during the
transient. Transients caused by changes in flow or pressure control
setpoints can also be modeled

Air valves

Air valves (also known as vacuum breaker valves) are used to protect
against low pressure conditions. AFT Impulse can model air valves,
including different inflow and outflow geometries.

Surge tanks

Surge tanks are a surge suppression device used in low pressure systems
with non-volatile fluids. AFT Impulse can model surge tanks, including
transient surface pressure for enclosed tanks.

Relief valves

The Relief Valve junction allows user-defined combinations of opening
and closing profiles based on parameters such as time or pressure. Users
can define a blowdown pressure for relief valves that close at pressures
below the set pressure. Relief valves can have constant backpressure
acting on the valve stem (hydraulically balanced) so the set points can
be defined as absolute upstream pressures, or the set points can be
entered as a pressure difference across the valve. For valves with
pressure profiles, the Cv profile for the valve can be user-defined or set
based on the valve set points. Users can also add opening and closing
rate limits.

Infinite pipe boundaries

Infinite pipe boundaries can be very useful for long, non-reflecting
pipes. Model run times can be significantly reduced with these elements.
Both Assigned Flow and Assigned Pressure junctions can be specified to
behave as infinite pipe boundaries during transients.



Non-Newtonian fluid modeling

AFT Impulse can model steady and transient flow of non-Newtonian
fluids which behave as Power Law, Bingham Plastic, Herschel-Bulkley,
or Homogeneous Scale-up viscosity models.

Pulp and paper modeling

AFT Impulse can model steady and transient flow of pulp and paper
stock using the Duffy method or Brecht & Heller method.

Repeat transient feature for periodic transient behavior

For elements which have periodic behavior (such as positive
displacement pumps), one cycle of data can be entered and then
specified to repeat once the cycle is finished.

Intermediate elevations for pipes

Typically, elevation changes along pipes do not affect the steady or
transient system. Exceptions are high points which cavitate. If desired,
AFT Impulse can model varying elevations along a pipe.

Fitting library

AFT Impulse offers a library of about 400 fitting losses which can be
added to pipes.

Design alerts

Design Alerts can be entered for pipes then cross-plotted vs. system
behavior. A common use is maximum allowed operating pressure.

Network libraries

Junction components and pipe materials can be saved to libraries for
later reuse. Libraries can be located on local PC's or deployed across
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local or wide area networks. The Library Manager allows users to
connect to relevant libraries for their specific pipe system design.

Compare input from different scenarios

The Scenario Comparison Tool can be used to compare pipe, junction
and general model file inputs for any number of scenarios in the model.
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